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Chapter 1

About Connect:Direct and Sterling Integrator
Interoperability

Sterling Integrator enables a business to define business processes in a software application and 
route data between enterprise systems using different protocols and formats.

Connect:Direct is a peer-to-peer data transfer application that uses a proprietary protocol to 
exchange data between Connect:Direct servers.

The Connect:Direct Server adapter is a component of Sterling Integrator that allows Sterling 
Integrator to act like a Connect:Direct server, sending and receiving data using the Connect:Direct 
protocol. The Connect:Direct Server adapter enables you to use files from a Connect:Direct server 
in a Sterling Integrator business process and to create business processes that exchange files with a 
Connect:Direct server.

Connect:Direct and Sterling Integrator Processes
Connect:Direct and Sterling Integrator each have their own version of a process. Connect:Direct 
uses a Process statement to initiate a session with another Connect:Direct node and then uses 
specific statements to perform tasks and make requests on that node.

Sterling Integrator uses business process services to initiate a session with another Connect:Direct 
node to perform tasks and make requests on that node. It is possible to use Sterling Integrator 
business processes to handle complex processes such as order fulfillment, invoicing, inventory, and 
other processes that require data exchange and business integration.

These business processes enable you to transfer your files, or business documents, to internal 
processing activities and to trading partners, exchanges, and customers.

Business Processes and Mailboxes
You can copy files from a Connect:Direct node directly to a Sterling Integrator business process or 
mailbox. Sterling Integrator business processes utilize services and adapters, such as the 
Connect:Direct Server Adapter User Guide 9



Chapter 1   About Connect:Direct and Sterling Integrator Interoperability
Connect:Direct Server adapter and related services, in a sequence of steps to achieve business goals. 
The Sterling Integrator Mailbox is a business document repository that enables you to organize, 
store, and manage trading partner documents and transactions.

Although staging and scheduling of data transmission is present to varying degrees in numerous 
applications and infrastructure components, it is beneficial to centralize the definition, operation, 
management, and control of this staging and scheduling. In Sterling Integrator, these capabilities 
are centralized in the Mailbox.

You can set up mailboxes within Sterling Integrator so that files copied over to Sterling Integrator 
are stored and retrieved later. When the files are stored in a mailbox, they are referred to as 
messages. You can also use mailbox routing rules to initiate business processes in Sterling 
Integrator based on messages that are stored in a mailbox.

Using Connect:Direct Server Adapter Services in a Business 
Process

The Connect:Direct Server adapter provides a suite of B2B services to establish communication 
between Sterling Integrator and Connect:Direct.

Using these services, you can create business processes to perform the same tasks performed with 
Connect:Direct Processes and with Connect:Direct commands.

The Connect:Direct Server services correspond to the Connect:Direct Process Language. These 
services work with the Connect:Direct Server adapter. These services are used when the 
Connect:Direct Server adapter is the PNODE.

The services created specifically for use with Connect:Direct are described in sample workflows in 
this user guide. These workflows demonstrate how each service is used within a business process.

The Connect:Direct Server adapter supports the following services:

✦ Connect:Direct Server Begin Session Service
✦ Connect:Direct Server BP Response Service
✦ Connect:Direct Server CopyFrom Service
✦ Connect:Direct Server CopyTo Service
✦ Connect:Direct Server End Session Service
✦ Connect:Direct Server Run Job Service
✦ Connect:Direct Server Run Task Service
✦ Connect:Direct Server Submit Service
10 Connect:Direct Server Adapter User Guide



Purpose of the User Guide
Purpose of the User Guide
The User Guide describes how to perform common user tasks with the Sterling Integrator 
Connect:Direct Server adapter and remote Connect:Direct servers. These tasks include:

✦ Use Connect:Direct to Copy a File to a Sterling Integrator Mailbox on page 21
✦ Use Connect:Direct to Copy a File to a Sterling Integrator Business Process on page 25
✦ Use Connect:Direct to Pull a File from Sterling Integrator on page 33
✦ Use Sterling Integrator to Copy a File to Connect:Direct on page 43
✦ Use Sterling Integrator to Copy a File from Connect:Direct on page 51
✦ Add Error Handling to Sterling Integrator Business Process on page 59
✦ Add Secure+ Option on page 67
✦ Use Sterling Integrator to Submit a Connect:Direct Process on page 73
✦ Use Sterling Integrator to Start a Connect:Direct Run Job on page 81
✦ Use Sterling Integrator to Start a Connect:Direct Run Task on page 89
✦ Hide the Connect:Direct Password in the Business Process on page 97

Requirements
Interoperability between Sterling Integrator and Connect:Direct has the following system 
requirements:

Supported Connect:Direct Versions
The following versions of Connect:Direct support interoperability with Sterling Integrator:

✦ Connect:Direct for Windows 4.2 or later
✦ Connect:Direct for UNIX 3.7 or later
✦ Connect:Direct for z/OS 4.6 or later
✦ Connect:Direct HP NonStop 3.3 or later
✦ Connect:Direct Select 1.0 or later

Supported Sterling Integrator Versions
Sterling Integrator versions 4.2 or later support interoperability with Connect:Direct.
Connect:Direct Server Adapter User Guide 11
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Chapter 2

Setup Procedures

Before you can transfer files or initiate processes between Connect:Direct servers and the Sterling 
Integrator Connect:Direct Server adapter, perform the following:

✦ Create Connect:Direct and Sterling Integrator User IDs on page 13
✦ Configure a Sterling Integrator Netmap Entry on page 13
✦ Configure a Sterling Integrator Connect:Direct Server Adapter on page 17
✦ Add Connect:Direct Server Adapter Node to Connect:Direct Netmap on page 19

Create Connect:Direct and Sterling Integrator User IDs
Your Sterling Integrator administrator must create a Sterling Integrator User ID for you. The 
administrator must give this User ID permission to execute Sterling Integrator business processes 
that you copy files to or from. When you create your Connect:Direct processes, use this Sterling 
Integrator User ID as the SNODEID of the Process statement.

Your Connect:Direct administrator must create a Connect:Direct user account and give this account 
permission to copy files, submit processes, perform Run Jobs, and perform Run Tasks on the 
Connect:Direct node. When you create your Sterling Integrator business processes, use this 
Connect:Direct user account as the remote Connect:Direct User ID.

Configure a Sterling Integrator Netmap Entry
A node is a Connect:Direct server. Two Connect:Direct servers (local and remote) function together 
to perform data transfers. Either node can initiate the work by submitting a Process. 

During the transfer of data, the Connect:Direct server where the Process is initiated is the primary 
node (PNODE) and the secondary node (SNODE) is the partner node. 
Connect:Direct Server Adapter User Guide 13
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When a session is established, the node that initiates the session is the PNODE regardless of the 
direction of information flow. The other is the SNODE. The Process can specify work destined for 
either the PNODE or SNODE. 

The Connect:Direct Server adapter configuration identifies the remote nodes that it can 
communicate with through the use of a network map, called a netmap.

When you create a Connect:Direct Server adapter, you must specify a netmap.

Sterling Integrator version 4.3 and earlier does not support Sterling Integrator netmaps. In Sterling 
Integrator version 4.3 and earlier, you specify remote Connect:Direct nodes in the Connect:Direct 
Server adapter configuration. In Sterling Integrator version 5.0 and later, you specify a netmap in 
the Connect:Direct Server adapter.

In Sterling Integrator version 5.0 and later, you can configure a netmap in Sterling Integrator from 
the Administration menu by selecting Deployment > Adapter utilities > C:D Netmaps.

From this menu, you can configure:

✦ Connect:Direct Nodes
✦ Connect:Direct Netmaps
✦ Connect:Direct Netmap cross-references (X-REF)

Connect:Direct Nodes
Create a Connect:Direct node definition for each remote Connect:Direct node that communicates 
with the Sterling Integrator Connect:Direct Server adapter.

Use the following procedure to create a new Connect:Direct node:

1. From the Administration menu, select Deployment > Adapter Utilities > C:D Netmaps > C:D 
Nodes.

2. In the Create Nodes pane, click Go!. The Create Nodes page appears.

Note: Sterling Integrator can be a Connect:Direct local or remote node and can function as a PNODE or 
an SNODE.

Note: If you make changes to an existing netmap, you must disable and re-enable the Connect:Direct 
Server adapter for the changes to take effect.

Field Value to Enter Description

Connect:Direct 
Server Node Name

Type the node name for the 
Connect:Direct server.

Name that will be used to identify the Connect:Direct 
server. Required.

Connect:Direct 
Server Host

Type the host name or IP address for 
the Connect:Direct server.

Required.
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3. Click Next. The Confirm page appears.
4. Review your configuration settings and click Finish.

Connect:Direct Netmaps
Once you have defined at least one Connect:Direct node you want to use, you can create a netmap. 
When you configure a Connect:Direct Server adapter, you must specify the netmap you want to use 
rather than the individual Connect:Direct nodes you want to communicate with. The individual 
Connect:Direct nodes are associated with netmaps with cross references. This arrangement is very 
flexible and allows you to:

✦ Define each Connect:Direct node one time no matter how many Connect:Direct Server 
adapters you have.

✦ Use the same netmap for multiple Connect:Direct Server adapters.
✦ Create specialized netmaps for different Connect:Direct Server adapters.
Use the following procedure to create a new Connect:Direct netmap:

1. From the C:D Netmaps menu, select C:D Netmaps. The C:D Netmaps page appears.

Connect:Direct Port Type the host port number for the 
Connect:Direct server.

TCP/IP port number that Connect:Direct monitors for 
requests from remote nodes. Required.

Max locally initiated 
(pnode) sessions 
allowed

During testing, set this value to 100 so 
that you do not run out of sessions.
After testing, if you require more than 
5 locally initiated concurrent sessions 
with remote Connect:Direct nodes, 
enter the estimated number of 
sessions. Otherwise, accept the 
default value of 5

Maximum number of sessions the Connect:Direct 
Server adapter may have active at any time. Required.
May be overridden at the node level. If a node-level 
value is configured, the effective session limit is the 
smaller of the two values: the limit for the adapter and 
the session limit for the remote node.
Valid value: Any number up to 9999. Minimum value is 
1. Default is 5.

Max remotely 
initiated (snode) 
sessions allowed

During testing, set this value to 100 so 
that you do not run out of sessions.
After testing, if you require more than 
5 remotely initiated concurrent 
sessions with remote Connect:Direct 
nodes, enter the estimated number of 
sessions. Otherwise, accept the 
default value of 5.

Maximum number of sessions from remote nodes that 
may be active at any point of time. Required.
May be overridden at the node level. If a node-level 
value is configured, the effective session limit is the 
smaller of the two values: the limit for the adapter and 
the session limit for the remote node.
Valid value: Any number up to 9999. Minimum value is 
1. Default is 5.

Secure+ Option Accept the default setting (Disabled) 
until you start using Secure+.
Files are not encrypted during copy 
operations.

Valid if Netmap Override=Yes at the Connect:Direct 
Server adapter. Indicate if you want to disable or 
enable encryption. Required.
Valid values are:

Disabled (default)

Enabled

Field Value to Enter Description
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2. In the Create New Netmap pane, click Go!. The Create Netmap page appears.

3. Click Next. The Confirm Page appears.
4. Review your configuration settings and click Finish.

Connect:Direct Netmap Cross-References
You can reuse nodes for a netmap or several netmaps by setting up a cross reference so you don’t 
have to create a new node for each Connect:Direct Server adapter.

Use the following procedure to create a new netmap cross reference:

1. From the C:D Netmaps menu, select C:D Netmap X-REF.
2. In the Create or Modify Netmap Cross Reference pane, click Go!. The Create Cross Reference 

page appears.

3. Click Next. The Confirm page appears.
4. Review your configuration settings and click Finish.

Field Value to Enter Description

Netmap Name Type the Connect:Direct netmap 
name.

Required.
Note: If you maintain multiple Connect:Direct 

Server adapters, you can use the same 
name for the netmap and Connect:Direct 
Server adapter for easier administration.

Netmap 
Description

Type the netmap description. Required.

Field Value to Enter Description

C:D Netmap Name Select the Connect:Direct netmap 
name that you created in 
Connect:Direct Netmaps on page 
15.

Select the Connect:Direct Netmap name. Required.

Add Node Click the plus sign to add a Node 
Name to the cross-reference. A new 
window appears, allowing you to 
select the Connect:Direct Node 
Name(s).
Select the node name that you 
created Connect:Direct Netmaps on 
page 15.
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Configure a Sterling Integrator Connect:Direct Server Adapter
The Sterling Integrator Connect:Direct Server adapter functions as both PNODE and SNODE in the 
Connect:Direct network, initiating and responding to Connect:Direct transfer requests. Configuring 
a Connect:Direct Server adapter is similar to configuring a Connect:Direct server.

Use the following procedure to configure a Connect:Direct Server adapter in Sterling Integrator:

1. From the Deployment menu, select Services > Configuration.
2. Click Go in the Create New Service pane.
3. In the Service Type box, type Connect:Direct Server Adapter and click Next.
4. Configure the following fields for this scenario. Accept default values for all other fields. For 

more information about all Connect:Direct Server adapter fields, refer to the Sterling 
Integrator online documentation.

Field Value to Enter Description

Name Type a unique name for the 
Connect:Direct Server adapter 
configuration.

Required.
Note: Name is the adapter name, not the node 

name. However, in Sterling Integrator 
business processes, Name is the 
CDLocalNodeName. To avoid confusion, use 
the same value for both Name and 
Connect:Direct Server Node Name in your 
Connect:Direct Server adapter configuration.

Description Type a description for the 
Connect:Direct Server adapter 
configuration.

Required

Connect:Direct 
Server Node Name

Type the node name to use to 
identify this Connect:Direct Server 
adapter. Best practice is to use the 
same value as the Name field.

Maximum 16 characters. This node name must match 
the Connect:Direct netmap entry for the Connect:Direct 
Server adapter. Required.

Connect:Direct 
Server Port

Type the listening port number for 
the Connect:Direct Server adapter.
Make sure you select a port number 
that is not in use by another 
application.

TCP/IP port number that Connect:Direct Server adapter 
monitors for requests from remote nodes. Required.
Note: If your application is installed on a UNIX 

operating system, do not select ports in the 
range 1-1024. These are normally reserved 
by the operating system.
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Max locally initiated 
(pnode) sessions 
allowed

During testing, set this value to 100 
so that you do not run out of 
sessions.
After testing, if you require more 
than 5 locally initiated concurrent 
sessions with remote 
Connect:Direct nodes, enter the 
estimated number of sessions. 
Otherwise, accept the default value 
of 5.
If you need to specify session limits 
for each node, set this value at the 
highest anticipated number of total, 
locally initiated sessions and then 
specify node limits in the netmap.

Maximum number of sessions the Connect:Direct 
Server adapter may have active at any point in time.
Required.
May be overridden at the node level. If a node-level 
value is configured, the effective session limit is the 
smaller of two values: the limit for the adapter and the 
session limit for the remote node.
Valid value: Any number through 9999. Minimum value 
is 1. Default is 5.

Max remotely 
initiated (snode) 
sessions allowed

During testing, set this value to 100 
so that you do not run out of 
sessions.
After testing, if you require more 
than 5 remotely initiated concurrent 
sessions with remote 
Connect:Direct nodes, enter the 
estimated number of sessions. 
Otherwise, accept the default value 
of 5.
If you need to specify session limits 
for each node, set this value at the 
highest anticipated number of total, 
remotely initiated sessions and then 
specify node limits in the netmap.

Maximum number of sessions from remote nodes that 
may be active at any point in time. 
Required.
May be overridden at the node level. If a node-level 
value is configured, the effective session limit is the 
smaller of two values: the limit for the adapter and the 
session limit for the remote node.
Valid value: Any number through 9999. Minimum value 
is 1. Default is 5.

Netmap Check For testing purposes, select the 
default (No). 

Whether the node netmap should be checked to 
authorize sessions. Required values are:

Check both node name and IP address—Searches 
the Connect:Direct Server adapter network map for 
an entry corresponding to the node name of the 
remote client. If one exists, the IP address is 
obtained and compared to the IP address of the 
remote node making the request.

Check node name only—Searches the 
Connect:Direct Server adapter network map for an 
entry corresponding to the node name of the remote 
client.

No (default)—Disables netmap validation.

Netmap Select the netmap name you 
created in Connect:Direct Netmaps 
on page 15.

Field Value to Enter Description
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5. On the Confirm page, review your configuration settings, select Enable Service for Business 
Processes and click Finish.
This will complete the Connect:Direct Server adapter configuration and start the adapter.

Add Connect:Direct Server Adapter Node to Connect:Direct 
Netmap

On your Connect:Direct server, add the Sterling Integrator Connect:Direct Server adapter node 
information to your Connect:Direct netmap with the following settings:

Encryption using 
Secure+

Select the default setting (Disabled) 
until you start using Secure+.

Whether Secure+ is enabled. Required. Valid values are 
Enabled and Disabled. Default is Disabled.

Parameter Value

Node Name The node name of the Sterling Integrator 
Connect:Direct Server adapter.

Operating System The operating system for your Sterling Integrator 
system.

Host/IP Address Host or IP address of your Sterling Integrator system

Port/Service Port/Service of your Sterling Integrator Connect:Direct 
Server adapter

Mode Override Mode1

Selected Communication Path TCPCommPath

Field Value to Enter Description
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Chapter 3

Use Connect:Direct to Copy a File to a
Sterling Integrator Mailbox

This chapter describes how to copy a file from a Connect:Direct server (PNODE) to a Sterling 
Integrator Connect:Direct Server adapter (SNODE). The Connect:Direct Server adapter passes this 
file to a Sterling Integrator Mailbox.

You can set up a mailbox rule so that a document copied to a mailbox triggers a Sterling Integrator 
business process. For more information about mailbox rules, refer to the Sterling Integrator online 
documentation.

Use the following workflow to copy a file from a Connect:Direct server to a Sterling Integrator 
mailbox:

✦ Create a Sterling Integrator Mailbox on page 22
✦ Create Your Connect:Direct Process on page 23
✦ Submit and Monitor Your Connect:Direct Process on page 23

Connect:Direct 
Server

(PNODE)

Connect:Direct 
Server Adapter

(SNODE)

Sterling Integrator

source file
destination

file
Mailbox
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Create a Sterling Integrator Mailbox
When you copy a file from Connect:Direct to Sterling Integrator, you must copy to a Sterling 
Integrator business process or mailbox. In this scenario, you copy a document to a mailbox. 

Use the following procedure to create and configure the Sterling Integrator mailbox:

1. Log in to Sterling Integrator.
2. From the Deployment menu, select Mailboxes > Configuration. 
3. On the Mailbox Configuration page, click Go! in the Create a new Mailbox pane.
4. On the Mailbox Name page, highlight the forward-slash in the Select pane.

5. In the Name box, type the name of your mailbox.
6. In the Description box, type a short description for your mailbox and click Next.
7. On the Assign Groups page, click Next.
8. On the Assign Users page, select your Sterling Integrator User ID in the Available Users pane 

and click the right-arrow to move your User ID to the Selected Users pane.
9. Click Next.
10. On the Confirm page, click Finish to create your mailbox.

Note: You do not create a virtual root for your mailbox in this workflow. If you need to create a virtual 
root for your mailbox, refer to the Sterling Integrator online documentation.

Note: If you are required to specify a virtual root for your mailbox, highlight the mailbox or mailbox 
path in the Select pane for your virtual root.
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Create Your Connect:Direct Process
Create the following Connect:Direct process:

This Connect:Direct process copies yourSourceFile from your Connect:Direct server to the Sterling 
Integrator Connect:Direct Server adapter, which passes the document to your mailbox. There are 
three parts to the destination FILE name in this Copy step:

✦ /mailbox/ is a reserve word and signals to Sterling Integrator that you are copying to a 
Mailbox.

✦ yourMailbox includes the name of your Sterling Integration Mailbox.
✦ yourDestinationFile is the document that is passed to your mailbox by the Connect:Direct 

Server adapter. This document is stored in the mailbox. This document can be retrieved by an 
FTP client, business process or another Connect:Direct process.

Submit and Monitor Your Connect:Direct Process
Submit the Connect:Direct process.

Monitor with Connect:Direct
You can use Connect:Direct Select Statistics to monitor your Connect:Direct to Sterling Integrator 
processes.

If the Connect:Direct process is successful, the Select Statistics detail will report the following:

COPY2MB PROCESS 
SNODE=yourCDSANode
SNODEID=(yourUserID,password)

STEP1 COPY 
FROM (
FILE=yourSourceFile
)
TO (
FILE=/mailbox/yourMailbox/yourDestinationFile
DISP=RPL
)

PEND 

Attribute Value

Message ID SCPA000I

Message Text Copy operation successful

Destination File /mailbox/yourMailbox/yourDestinationFile
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If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

View the Mailbox Document in Sterling Integrator
You can view yourDestinationFile in your mailbox with Sterling Integrator.

Use the following procedure to view your mailbox document with Sterling Integrator:

1. From the Deployment menu, select Mailboxes > Messages.
2. On the Message Management page, select Filter by Name to display the Available Mailboxes 

pane.
3. In the Available Mailboxes pane, scroll down and highlight /yourMailbox and click the 

down-arrow to move /yourMailbox to the Selected Mailboxes pane.
4. Click Go! to display the search results.

Information about the yourDestinationFile document is displayed, including Document ID, 
Created date, Size, Mailbox, Extract Policy, Policy Value, and whether this document is 
locked by a business process.
In this example, yourDestinationFile has an Extraction Policy of Extractable. This means that 
users can extract this document from /yourMailbox an unlimited number of times with no 
expiration date and time. You can change the extraction policy for yourDestinationFile by 
clicking on the Edit link. If you need to change the extraction policy for documents you copy 
to mailboxes using Connect:Direct, edit your Connect:Direct Server adapter configuration for 
Extractability.

Note: You can also monitor your Connect:Direct process from the Business Process menu by navigating 
to Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.
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Chapter 4

Use Connect:Direct to Copy a File to a
Sterling Integrator Business Process

This chapter describes how to use Connect:Direct to copy a file to Sterling Integrator. In this 
scenario, the Connect:Direct server is the PNODE and the Sterling Integrator Connect:Direct 
Server adapter is the SNODE. The Connect:Direct Server adapter receives the file and passes it to 
a business process.

Use the following workflow to copy a file from Connect:Direct to a Sterling Integrator business 
process:

✦ Create a Sterling Integrator Business Process on page 25
✦ Check Your Business Process into Sterling Integrator on page 27
✦ Create Your Connect:Direct Process on page 28
✦ Submit and Monitor Your Connect:Direct Process on page 29

Create a Sterling Integrator Business Process
When you copy a file from Connect:Direct to Sterling Integrator, you must copy to a Sterling 
Integrator business process or mailbox. In this scenario, you are copying a document to a business 
process. This business process contains a service that provides information about the source file.
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Use the Sterling Integrator Graphical Process Modeler to create and modify business processes. 
Individual services and adapters are represented by icons in the Modeler. 

Use the following procedure to create the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. From the View menu, select Stencil > BPML. This will add the BPML stencil to the GPM. 

The BPML stencil contains BPML icons to use in your business processes.
4. From the View menu, select Stencil > Sync Mode. This will add the Sync Mode stencil to the 

GPM. 
The Sync Mode stencil contains an icon you will need in your business processes.

5. From the File menu, select New to open a new business process.
6. Drag and drop the following icons from the BPML and Sync Mode stencils into the Business 

Process window in the following order, from left to right:

Start

Get Document Information Service

End

7. To link the icons:
a. Click the arrow on the right side of the Start icon and drag it to the arrow on the left side of 

the Get Document Information Service icon.
b. Click the arrow on the right side of the Get Document Information Service icon and drag it 

to the arrow on the left side of the End icon.

All business processes begin with a Start icon and end with an End icon. In this business 
process, the Get Documentation Information Service provides information about the primary 
document.
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8. Configure the Get Document Information Service using the following procedure:
a. Double-click the Get Document Information Service icon. This opens the Service Editor 

window.
b. In the Service Editor-Get Documentation Information Service window, select 

GetDocumentInfoService from the Config drop-down list.

In this step you specify the pre-defined GetDocumentInfoService configuration for the Get 
Document Information Service. You can override configuration values in the Service Editor.

9. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

10. On the Save dialog box, type the business process file name in the File Name box and click 
Save. 
Remember where you save this file.

Check Your Business Process into Sterling Integrator
Use the following procedure to check the business process into Sterling Integrator:

1. Log in to Sterling Integrator.

Note: To see a sample business process, refer to Sample Business Process: Copy a File from 
Connect:Direct to Sterling Integrator on page 105.
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2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Create Process Definition pane, click Go!.
4. Type the name of your business process in the Name box.
5. Under Select an input mode for defining the new process, select Check in Business Process 

created by the graphical modeling tool and click Next.
6. On the Check-in page, click Browse and navigate to the business process file name that you 

saved in step 10 of the previous procedure.
7. Type a short description for your business process in the Description box and click Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full and click Next.
11. On the Deadline Settings page, click Next.
12. On the Life Span page, click Next.
13. On the Confirm page, select the Enable Business Process box.
14. Select the Create Permission box. 

This adds the business process to the list of Sterling Integrator security permissions. This 
makes it possible to assign permission for this business process to the user account.

15. Click Finish.

Create Your Connect:Direct Process
Create the following Connect:Direct process:

Note: The Sterling Integrator administrator must assign your Sterling Integrator User ID permission to run 
this business process.

COPY2SI PROCESS 
SNODE=yourCDSANode
SNODEID=(yourUserID,password)

STEP1 COPY 
FROM (
FILE=yourSourceFile
)
TO (
FILE=/businessprocess/yourBusinessProcess/yourDestinationFile
DISP=RPL
)

PEND 
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This Connect:Direct process copies yourSourceFile from your Connect:Direct server to the Sterling 
Integrator Connect:Direct Server adapter, yourCDSANode, which invokes your business process. 
The SNODEID, yourUserID, is your Sterling Integrator User ID. There are three parts to the 
destination FILE name in this Copy step:

✦ /businessprocess/ is a reserve word and signals to Sterling Integrator that you are copying to a 
business process.

✦ yourBusinessProcess is the name of the Sterling Integration business process that the 
Connect:Direct Server adapter invokes.

✦ yourDestinationFile is the name of the document that is passed to the business process by the 
Connect:Direct Server adapter. This document becomes the Primary Document in the 
yourBusinessProcess business process. The primary document is the document that the 
services in a business process act on or in relation to; this is usually the document passed to a 
business process by the initiating adapter.

Submit and Monitor Your Connect:Direct Process
Submit the Connect:Direct process.

Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your Connect:Direct to Sterling 
Integrator processes.

If the Connect:Direct process is successful, the Select Statistics detail will report the following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Monitor with Sterling Integrator
You can also use Sterling Integrator to monitor your Connect:Direct to Sterling Integrator 
processes.

Use the following procedure to monitor your Connect:Direct process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.

Attribute Value

Message ID SCPA000I

Message Text Copy operation successful

Destination File /businessprocess/yourBusinessProcess/yourDestinationFile
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2. In the Search Using Business Process Name pane, select yourBusinessProcess in the Business 
Processes list and click Go!.

The Monitor page displays the following information:

If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number

Name The business process name

State The current state of the business process
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3. Click the ID number to see details about the business process execution.

The Business Process Detail page displays the following information:

4. Click the Document info link for Step 1, GetDocumentInfo service. 
The PrimaryDocument page displays the contents of the Primary Document, 
yourDestinationFile.

5. Close the PrimaryDocument page.
6. From the Business Process Detail page, click the Instance Data info link for Step 1, 

GetDocumentInfo service.

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step
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The Process Data page displays process data for the business process. The data is presented in 
XML format as shown:

In this example, the Get Document Information Service puts information about the Primary 
Document, such as the BodyName and BodyLength, into process data.

<?xml version="1.0" encoding="UTF-8"?>
<ProcessData>
  <PrimaryDocument SCIObjectID="oxnard:node1:11efefe9db6:26492407"/>
  <CDServerNodeData>
    <RemoteFileName>C:\source.txt</RemoteFileName>
    <PnodeName>CDWIN</PnodeName>
    <LocalFileName>/businessprocess/ReceiveFromCD/dest.txt</LocalFileName>
    <SnodeName>SI50CD</SnodeName>
  </CDServerNodeData>
  <BodyName>dest.txt</BodyName>
  <BodyLength>5</BodyLength>
  <DocumentBodyLength>5</DocumentBodyLength>
  <DocumentLength>5</DocumentLength>
  <DocumentName>dest.txt</DocumentName>
  <DocumentId>oxnard:node1:11efefe9db6:26492400</DocumentId>
...
</ProcessData>

Note: You can also monitor your business processes from the Business Process menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.
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Chapter 5

Use Connect:Direct to Pull a File from
Sterling Integrator

This chapter describes how to pull a file from a Sterling Integrator Connect:Direct Server adapter 
(SNODE) using the Connect:Direct node (PNODE). The Connect:Direct node connects to the 
Sterling Integrator Connect:Direct Server adapter which invokes a business process. This business 
process passes a document back to the Connect:Direct Server adapter which sends the file back to 
the Connect:Direct node.

Use the following workflow to pull a file from Sterling Integrator to a Connect:Direct server:

✦ Configure a File System Adapter on page 34
✦ Create a Sterling Integrator Business Process on page 36
✦ Check Your Business Process into Sterling Integrator on page 38
✦ Create Your Connect:Direct Process on page 39
✦ Submit and Monitor Your Connect:Direct Process on page 39
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Configure a File System Adapter
Use the File System Adapter within a Sterling Integrator business process to collect a file from the 
Sterling Integrator file system. Use the following procedure to create the directory and file for the 
File System Adapter:

1. Create a collection directory on the Sterling Integrator file system.
2. Create a source file in the collection directory. 
3. Add the some text to the file so that you can verify that Connect:Direct pulls the correct file.
4. Create an extraction directory on the Sterling Integrator file system. 

An extraction directory is required to configure a File System Adapter configuration, but it is 
not used to extract files in this example.

Before you can use the File System Adapter in a business process, create a configuration of the 
adapter in Sterling Integrator. Use the following procedure to configure a File System Adapter:

1. Log in to Sterling Integrator and navigate to Deployment > Services > Configuration.
2. On the Services Configuration page, click Go! in the Create New Service pane.
3. In the Service Type box, type File System Adapter and click Next.

Field Value to Enter Description

Name Type a unique name for the File 
System Adapter service 
configuration.

Required.

Description Type a meaningful description for 
the File System Adapter service 
configuration.

Required.

Collection folder Specify the collection folder you 
created above.

The name of the folder or subfolder on the same 
computer where Application is installed and where it 
collects (or picks up) files as part of a business process. If 
the path of the folder is not included as part of the name, 
the folder is assumed to be in the Application working 
directory.
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4. Click Finish to save the configuration.

Filename filter Specify the filter to match the file 
you created in the collection folder 
above.

Collect only files that match a specified filter within the 
collection folder. Optional.
Examples include:

*.txt (collects only .txt files)

*.dat (collects only .dat files)

EDI.* (collects only files named EDI with any file 
extension)

EDI.txt (collects only files named EDI with a file 
extension of .txt)

Note: If there are multiple files in the collection folder 
and you leave this field blank, one of the 
following occurs:

If the adapter is configured to start a business 
process, it processes all files in the collection folder.

If the adapter is within a business process, it collects 
only the first file in the folder.

Collect files from 
subfolders within 
and including the 
collection folder?

Select No for this scenario so that 
the File System Adapter does not 
collect files from subfolders of the 
collection folder.

Whether to scan for files in subfolders of the collection 
folder. Required.
Valid values:
Yes—Collects files in the specified folder and all 
subfolders.
No—Collects files in the specified folder only.

User absolute file 
path name for the 
document name?

Select No for this scenario so that 
the document name does not 
include the path name.

Whether to keep the absolute path name of the files 
collected when assigning the document name. Required.
Valid values:
Yes—The absolute file path name is kept with the 
document in the business process. Choose this value if 
your business process requires the path information to 
precede the file name.
No—Only the file name is kept with the document in the 
business process.

Start a business 
process once files 
are collected?

Select No for this scenario. 
Since you use the File System 
Adapter within a business 
process, there is no need to start 
another business process.

Whether to start a business process using the File 
System adapter after files are collected. Required.
Valid values:
Yes—Starts the business process specified from the 
business process drop-down list.
No—No business process will be started.

Extraction folder Select No for this scenario.
The File System Adapter collects 
a file, but does not write (extract) 
a file in this scenario.

The name of the folder or subfolder on the same 
computer where Application is installed and where it 
installs (or writes) data from the primary document as part 
of a business process. If you do not include the file path 
for the folder as part of the name, the folder is assumed to 
be in the Application working directory. Required.

Field Value to Enter Description
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Create a Sterling Integrator Business Process
When you use Connect:Direct to pull a file from Sterling Integrator, you invoke a Sterling 
Integrator business process. This business process contains a CD Server BP Response Service that 
sends the primary document back to Connect:Direct. 

In this example, the business process uses a File System adapter to collect a file from the Sterling 
Integrator file System. This file becomes the primary document in the business process. The CD 
Server BP Response Service then sends the primary document to the Connect:Direct node via the 
Connect:Direct Server adapter.

Use the following procedure to create the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the BPML stencil is not visible in the GPM, navigate to the View menu and select Stencil > 

BPML. 
This will add the BPML stencil to the GPM.

4. If the Sync Mode stencil is not visible in the GPM, navigate to the View menu and select 
Stencil > Sync Mode. 
This will add the Sync Mode stencil to the GPM.

5. From the View menu, select Stencil > Applications > Sterling Commerce > Connect:Direct. 
This will add the Connect:Direct stencil to the GPM. The Connect:Direct stencil contains an 
icon you will need in your business processes.

6. From the File menu, select New to open a new business process.
7. Drag and drop the following icons from the BPML, Sync Mode, and Connect:Direct stencils 

into the Business Process window in the following order, from left to right:

Start

File System Adapter

CD Server BP Response Service

End

8. To link the icons:
a. Click the arrow on the right side of the Start icon and drag it to the arrow on the left side of 

the File System Adapter icon.
b. Click the arrow on the right side of the File System Adapter icon and drag it to the arrow 

on the left side of the CD Server BP Response Service icon.
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c. Click the arrow on the right side of the CD Server BP Response Service icon and drag it to 
the arrow on the left side of the End icon.

9. Configure the File System Adapter using the following procedure:
a. Double-click the File System Adapter icon.
b. In the Service Editor-File System Adapter window, select your File System Adapter 

configuration from the Config drop-down list. The Message To Service tab is displayed.
In this step you specify the configuration that you created for the File System Adapter. 
You can override configuration values in the Service Editor.

c. On the Message to Service tab, select Collection as the Value for Action. 
This causes the File System Adapter to collect files from the collection folder.

d. Select No as the Value for deleteAfterCollect. 
If deleteAfterCollect is set to Yes, the File System Adapter deletes the files in the 
collection folder after it collects them. When you are testing this business process, keep 
this value set to No so that you don’t have to replace the source file after each test run.
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10. Configure the CD Server BP Response Service using the following procedure:
a. Double-click the CD Server BP Response Service icon. 

This opens the Service Editor window.
b. In the Service Editor-CD Server BP Response Service window, select 

CDServerBPResponse from the Config drop-down list.
In this step you specify the pre-defined CDServerBPResponse configuration for the CD 
Server BP Response Service. You can override configuration values in the Service Editor.

11. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

12. On the Save dialog box, type the name of your business process in the File Name box and 
click Save. 
Remember where you save this file.

Check Your Business Process into Sterling Integrator
Use the following procedure to check the business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Create Process Definition pane, click Go!.
4. Type your business process name in the Name box.
5. Under Select an input mode for defining the new process, select Check in Business Process 

created by the graphical modeling tool and click Next.
6. On the Check-in page, click Browse and navigate to the business process file that you saved in 

step 12 of the previous procedure.
7. Type a short description of the business process in the Description box and click Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full and click Next.
11. On the Deadline Settings page, click Next.
12. On the Life Span page, click Next.
13. On the Confirm page, select the Enable Business Process box.

Note: To see a sample business process, refer to Sample Business Process: Pull a File from Sterling 
Integrator to Connect:Direct on page 106.
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14. Select the Create Permission box. 
This adds the business process to the list of Sterling Integrator security permissions. This 
makes it possible to assign permission for this business process to the user account.

15. Click Finish.

Create Your Connect:Direct Process
Create the following Connect:Direct process:

This Connect:Direct process retrieves yourSourceFile from the Sterling Integrator Connect:Direct 
Server adapter which receives the file from your business process. There are three parts to the 
FROM FILE name in the Copy step:

✦ /businessprocess/ is a reserve word and signals to Sterling Integrator that you are invoking a 
business process.

✦ yourBusinessProcess is the name of the Sterling Integration business process that the 
Connect:Direct Server adapter invokes.

✦ yourDestinationFile is the name of the document that is passed from the Sterling Integrator 
Connect:Direct Server adapter to your Connect:Direct node. This document is the Primary 
Document in your business process.

Submit and Monitor Your Connect:Direct Process
Submit the Connect:Direct process.

PULLFILE PROCESS 
SNODE=yourCDSANode
SNODEID=(yourUserID,password)

STEP1 COPY 
FROM (
FILE=/businessprocess/yourBusinessProcess/yourSourceFile
SNODE
)
TO (
FILE=yourDestinationFile
PNODE
DISP=RPL
)

PEND 
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Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your Connect:Direct to Sterling 
Integrator processes.

If the Connect:Direct process is successful, the Select Statistics detail will report the following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Monitor with Sterling Integrator
Use the following procedure to monitor your Connect:Direct process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process in the Business 

Processes list and click Go!.
The Monitor page displays the following information:

If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.
3. Click the ID number to see details about the business process execution.

The Business Process Detail page displays the following information:

Attribute Value

Message ID SCPA000I

Message Text Copy operation successful

Source File /businessprocess/yourBusinessProcess/yourSourceFile

Destination File <default download directory>\yourDestinationFile

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number

Name The business process name

State The current state of the business process

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step
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4. Click the Document info link for the Connect:Direct Server Response Service. 
The PrimaryDocument page displays the contents of the primary document.

5. Close the PrimaryDocument page.

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step

Note: You can also monitor your business processes from the Business Process menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.

Label Description
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Chapter 6

Use Sterling Integrator to Copy a File to
Connect:Direct

This chapter describes how to copy a file from Sterling Integrator to Connect:Direct. The Sterling 
Integrator business process passes a document to the Connect:Direct Server adapter (PNODE) 
which copies the file to the Connect:Direct node (SNODE). The business process functions much 
like a Connect:Direct process.

Use the following workflow to copy a file from Sterling Integrator to a Connect:Direct server:

✦ Create a Sterling Integrator Business Process on page 44
✦ Check Your Business Process into Sterling Integrator on page 47
✦ Submit and Monitor Your Sterling Integrator Business Process on page 48

Connect:Direct 
Server

(SNODE)

Connect:Direct 
Server Adapter

(PNODE)

Sterling Integrator

Business Process

destination

file

source file
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Create a Sterling Integrator Business Process
When you use Sterling Integrator to copy a file to Connect:Direct, you execute a Sterling Integrator 
business process that contains Connect:Direct Server adapter services to send the primary document 
to Connect:Direct. 

Use the following procedure to create the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the BPML stencil is not visible in the GPM, navigate to the View menu and select Stencil > 

BPML. 
This will add the BPML stencil to the GPM.

4. From the View menu, select Stencil > Applications > Sterling Commerce > Connect:Direct. 
This will add the Connect:Direct stencil to the GPM.

5. From the File menu, select New to open a new business process.
6. Drag and drop the following icons from the BPML and Connect:Direct stencils into the 

Business Process window in the following order, from left to right:

Start

CD Server Begin Session Service

CD Server CopyTo Service

CD Server End Session Service

End

7. To link the icons:
a. Click the arrow on the right side of the Start icon and drag it to the arrow on the left side of 

the CD Server Begin Session Service icon.
b. Click the arrow on the right side of the CD Server Begin Session Service icon and drag it 

to the arrow on the left side of the CD Server CopyTo Service icon.
c. Click the arrow on the right side of the CD Server CopyTo Service icon and drag it to the 

arrow on the left side of the CD Server End Session Service icon.
d. Click the arrow on the right side of the CD Server End Session Service icon and drag it to 

the arrow on the left side of the End icon.
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8. Configure the CD Server Begin Session Service using the following procedure:
a. Double-click the CD Server Begin Session Service icon.

The CD Server Begin Session Service functions like the Connect:Direct Process 
statement. It initiates a session on a specified remote Connect:Direct node.

b. In the Service Editor-CD Server Begin Session Service window, select 
CDServerBeginSession from the Config drop-down list. The Message To Service tab is 
displayed.
In this step you specify the pre-defined CDServerBeginSession configuration for the CD 
Server Begin Session Service. You can override configuration values in the Service 
Editor.

c. Select your Connect:Direct Server adapter node name as the Value for 
LocalCDNodeName.

d. Type the remote Connect:Direct node name as the Value for RemoteCDNodeName.
e. Type the Connect:Direct User ID as the Value for RemoteUserId.

f. Type the password for the Connect:Direct User ID as the Value for RemotePasswd.
g. Select No as the Value for UsingObscuredPasswd.

9. Click the Message From Service tab.
10. Select Allow message write for Input Msg.
11. Click Add and add the following information to the new record:

In the Name box, type BeginSessionResults.

Note: You must add the Connect:Direct User ID to your Connect:Direct User Authorities.
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In the Value field, type *.

Select the Use XPATH? check box.

12. Configure the CD Server CopyTo Service using the following procedure:
a. Double-click the CD Server CopyTo Service icon. This opens the Service Editor window.

The CD Server CopyTo Service functions like the Connect:Direct Copy statement. It 
copies a file from the PNODE to the SNODE.

b. In the Service Editor-CD Server CopyTo Service window, select CDServerCopyTo from 
the Config drop-down list.
In this step you specify the pre-defined CDServerCopyTo configuration to use for the CD 
Server CopyTo Service. You can override configuration values in the Service Editor.

c. Type rpl as the Value for CDDisposition. 
This is equivalent to DISP=RPL in a Connect:Direct Copy statement.

d. Type the destination file name as the Value for RemoteFileName.
e. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 

select the Use XPATH? box.
The Session Token is created by the CD Server Begin Session Service and identifies the 
session that is established with the remote Connect:Direct node. The SessionToken value 
in the CD Server CopyTo Service ensures that this service copies the file using the session 
initiated by the CD Server Begin Session Service.

13. Configure the CD Server End Session Service using the following procedure:
a. Double-click the CD Server End Session Service icon.

The CD Server End Session Service functions like the Connect:Direct End statement. It 
terminates the session with the remote Connect:Direct node. If the CD Server End Session 
does not execute, the session remains open.
46 Connect:Direct Server Adapter User Guide



Check Your Business Process into Sterling Integrator
b. In the Service Editor-CD Server End Session Service window, select 
CDServerEndSession from the Config drop-down list.
In this step you specify the pre-defined CDServerEndSession configuration to use for the 
CD Server End Session Service. You can override configuration values in the Service 
Editor.

c. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 
select the Use XPATH? box.
The SessionToken value in the CD Server End Session Service ensures that this service 
closes the session initiated by the CD Server Begin Session Service.

14. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

15. On the Save dialog box, type your business process file name in the File Name box and click 
Save. 
Remember where you save this file.

Check Your Business Process into Sterling Integrator
Use the following procedure to check your business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Create Process Definition pane, click Go!.
4. Type your business process name in the Name box.
5. Under Select an input mode for defining the new process, select Check in Business Process 

created by the graphical modeling tool and click Next.
6. On the Check-in page, click Browse and navigate to your business process file that you saved 

in step 15 of the previous procedure.
7. Type a short description of your business process in the Description box and click Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full.
11. Set the Recovery Level to Auto Resume and click Next.

If Sterling Integrator stops responding during a copy transaction and the recovery level is set 
to Auto Resume, the business process resumes automatically at the next Sterling Integrator 
start up.

Note: To see a sample business process, refer to Sample Business Process: Copy a File from Sterling 
Integrator to Connect:Direct on page 107.
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12. On the Deadline Settings page, click Next.
13. On the Life Span page, click Next.
14. On the Confirm page, select the Enable Business Process box.
15. Click Finish.

Submit and Monitor Your Sterling Integrator Business 
Process

Use the following procedure to submit your Sterling Integrator business process:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. In the Search pane, type your business process name in the Process Name box and click Go!.
4. On the Business Process Manager page, click Execution Manager.
5. On the Execution Manager page, click Execute to launch the Execute Business Process Input 

dialog box.
6. Click Browse and navigate to your source file on your local system and click Open.

This is the file that the business process will copy to the Connect:Direct server.

7. Click Go! to submit the business process. 
The Execute Business Process page is displayed. 

8. Close the Execute Business Process page.
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Monitor with Sterling Integrator
Use the following procedure to monitor your business process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process name in the 

Business Processes list and click Go!.
The Monitor page displays the following information:

If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.
3. Click the ID number to see details about the business process execution.

The Business Process Detail page displays the following information for each step:

4. Click the Status Report link for the Connect:Direct Server Primitive CopyTo Service. 
The Status Report displays a short summary of the CopyTo operation including the destination 
file name and number of bytes copied.

5. Click the Document info link for the Connect:Direct Server Primitive CopyTo Service. 
The PrimaryDocument page displays the contents of the Primary Document.

6. Close the PrimaryDocument page.

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number

Name The business process name

State The current state of the business process

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step
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7. From the Business Process Detail page, click the Instance Data info link for the 
Connect:Direct Server Primitive CopyTo Service.
The Process Data page displays process data for the business process. The data is presented in 
XML format and contains several fields and values, such as:

Remote Node—node name of the remote Connect:Direct server

Remote User—Connect:Direct User ID

Remote File Name—your destination file

8. The last step in the Business process Detail page is the CD Server End Session Service. The 
Status indicates that it successfully terminates the Connect:Direct session.

Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your Sterling Integrator to 
Connect:Direct business process.

If the Connect:Direct process is successful, the Select Statistics detail will report the following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Note: You can also monitor your business processes from the Business Processes menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.

Attribute Value

Message ID SCPA000I

Message Text Copy operation successful

Destination File <default download directory>\<your destination file>
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Use Sterling Integrator to Copy a File from
Connect:Direct

This chapter describes how to use Sterling Integrator to copy a file from Connect:Direct. The 
Sterling Integrator business process invokes the Connect:Direct Server adapter (PNODE) which 
copies the file from the Connect:Direct node (SNODE) and passes it back to the business process. 
The business process functions much like a Connect:Direct process.

Use the following workflow to copy a file from Sterling Integrator to a Connect:Direct server:

✦ Create a Sterling Integrator Business Process on page 52
✦ Check Your Business Process into Sterling Integrator on page 55
✦ Submit and Monitor Your Sterling Integrator Business Process on page 56

Connect:Direct
Server

SNODE

Connect:Direct 
Server Adapter

PNODE

Sterling Integrator

Business Processconnects
invokes

file
file
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Create a Sterling Integrator Business Process
When you use Sterling Integrator to copy a file from Connect:Direct, you execute a Sterling 
Integrator business process that contains Connect:Direct Server adapter services to copy the file 
from Connect:Direct.

Use the following procedure to create the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the BPML stencil is not visible in the GPM, navigate to the View menu and select Stencil > 

BPML. 
This will add the BPML stencil to the GPM.

4. From the View menu, select Stencil > Applications > Sterling Commerce > Connect:Direct. 
This will add the Connect:Direct stencil to the GPM.

5. From the File menu, select New to open a new business process.
6. Drag and drop the following icons from the BPML and Connect:Direct stencils into the 

Business Process window in the following order, from left to right:

Start

CD Server Begin Session Service

CD Server CopyFrom Service

CD Server End Session Service

End

7. To link the icons:
a. Click the arrow on the right side of the Start icon and drag it to the arrow on the left side of 

the CD Server Begin Session Service icon.
b. Click the arrow on the right side of the CD Server Begin Session Service icon and drag it 

to the arrow on the left side of the CD Server CopyTo Service icon.
c. Click the arrow on the right side of the CD Server CopyFrom Service icon and drag it to 

the arrow on the left side of the CD Server End Session Service icon.
d. Click the arrow on the right side of the CD Server End Session Service icon and drag it to 

the arrow on the left side of the End icon.
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8. Configure the CD Server Begin Session Service using the following procedure:
a. Double-click the CD Server Begin Session Service icon.

The CD Server Begin Session Service functions like the Connect:Direct Process 
statement. It initiates a session on a specified remote Connect:Direct node.

b. In the Service Editor-CD Server Begin Session Service window, select 
CDServerBeginSession from the Config drop-down list. The Message To Service tab is 
displayed.
In this step you specify the pre-defined CDServerBeginSession configuration for the CD 
Server Begin Session Service. You can override configuration values in the Service 
Editor.

c. Select your Connect:Direct Server adapter node name as the Value for 
LocalCDNodeName.

d. Type the remote Connect:Direct node name as the Value for RemoteCDNodeName.
e. Type the Connect:Direct User ID as the Value for RemoteUserId.

f. Type the password for the Connect:Direct User ID as the Value for RemotePasswd.
g. Select No as the Value for UsingObscuredPasswd.

9. Click the Message From Service tab.
10. Select Allow message write for Input Msg.
11. Click Add and add the following information to the new record:

In the Name box, type BeginSessionResults.

Note: You must add the Connect:Direct User ID to your Connect:Direct User Authorities.
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In the Value field, type *.

Select the Use XPATH? check box.

12. Configure the CD Server CopyFrom Service using the following procedure:
a. Double-click the CD Server CopyFrom Service icon. This opens the Service Editor 

window.
The CD Server CopyFrom Service functions like the Connect:Direct Copy statement. It 
copies a file from the SNODE to the PNODE.

b. In the Service Editor-CD Server CopyFrom Service window, select CDServerCopyFrom 
from the Config drop-down list.
In this step you specify the pre-defined CDServerCopyFrom configuration to use for the 
CD Server CopyFrom Service. You can override configuration values in the Service 
Editor.

c. Type the source file name as the Value for RemoteFileName. 
This file must reside on the file system of the Connect:Direct node.

d. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 
select the Use XPATH? box.
The Session Token is created by the CD Server Begin Session Service and identifies the 
session that is established with the remote Connect:Direct node. The SessionToken value 
in the CD Server CopyFrom Service ensures that this service copies the file using the 
session initiated by the CD Server Begin Session Service.

13. Configure the CD Server End Session Service using the following procedure:
a. Double-click the CD Server End Session Service icon.

The CD Server End Session Service functions like the Connect:Direct End statement. It 
terminates the session with the remote Connect:Direct node. If the CD Server End Session 
does not execute, the session remains open.
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b. In the Service Editor-CD Server End Session Service window, select 
CDServerEndSession from the Config drop-down list.
In this step you specify the pre-defined CDServerEndSession configuration to use for the 
CD Server End Session Service. You can override configuration values in the Service 
Editor.

c. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 
select the Use XPATH? box.
The SessionToken value in the CD Server End Session Service ensures that this service 
closes the session initiated by the CD Server Begin Session Service.

14. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

15. On the Save dialog box, type your business process file name in the File Name box and click 
Save. 
Remember where you save this file.

Check Your Business Process into Sterling Integrator
Use the following procedure to check your business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Create Process Definition pane, click Go!.
4. Type your business process name in the Name box.
5. Under Select an input mode for defining the new process, select Check in Business Process 

created by the graphical modeling tool and click Next.
6. On the Check-in page, click Browse and navigate to your business process file that you saved 

in step 15 of the previous procedure.
7. Type a short description of your business process in the Description box and click Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full.
11. Set the Recovery Level to Auto Resume and click Next.

If Sterling Integrator stops responding during a copy transaction and the recovery level is set 
to Auto Resume, the business process resumes automatically at the next Sterling Integrator 
start up.

Note: To see a sample business process, refer to Sample Business Process: Copy a File from 
Connect:Direct to Sterling Integrator on page 109.
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12. On the Deadline Settings page, click Next.
13. On the Life Span page, click Next.
14. On the Confirm page, select the Enable Business Process box.
15. Click Finish.

Submit and Monitor Your Sterling Integrator Business 
Process

Use the following procedure to submit your Sterling Integrator business process:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. In the Search pane, type your business process name in the Process Name box and click Go!.
4. On the Business Process Manager page, click Execution Manager.
5. On the Execution Manager page, click Execute to launch the Execute Business Process Input 

dialog box.
6. Click Go! to submit the business process. 

The Execute Business Process page is displayed. 
7. Close the Execute Business Process page.

Monitor with Sterling Integrator
Use the following procedure to monitor your business process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process name in the 

Business Processes list and click Go!.
The Monitor page displays the following information:

If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number

Name The business process name

State The current state of the business process
56 Connect:Direct Server Adapter User Guide



Submit and Monitor Your Sterling Integrator Business Process
3. Click the ID number to see details about the business process execution.
The Business Process Detail page displays the following information for each step:

4. Click the Status Report link for the Connect:Direct Server Primitive CopyFrom Service. 
The Status Report displays a short summary of the CopyFrom operation including the source 
file name and number of bytes copied.

5. Click the Document info link for the Connect:Direct Server Primitive CopyFrom Service. 
The PrimaryDocument page displays the contents of the Primary Document.

6. Close the PrimaryDocument page.
7. From the Business Process Detail page, click the Instance Data info link for the 

Connect:Direct Server Primitive CopyFrom Service.
The Process Data page displays process data for the business process. The data is presented in 
XML format and contains several fields and values, such as:

Remote Node—node name of the remote Connect:Direct server

Remote User—Connect:Direct User ID

Remote File Name—your source file

8. The last step in the Business process Detail page is the CD Server End Session Service. The 
Status indicates that it successfully terminates the Connect:Direct session.

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step

Note: You can also monitor your business processes from the Business Processes menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.
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Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your Sterling Integrator to 
Connect:Direct business process.

If the Connect:Direct process is successful, the Select Statistics detail will report the following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Attribute Value

Message ID SCPA000I

Message Text Copy operation successful

Source File <default upload directory>\<your source file>
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Add Error Handling to Sterling Integrator
Business Process

This chapter describes how to add error handling to an existing Sterling Integrator business process. 
The business process passes a document to the Connect:Direct Server adapter (PNODE) which 
copies the file to the Connect:Direct node (SNODE). The error handling ensures that the 
Connect:Direct session closes if an error is encountered during the session.

You can add OnFault Groups to your business processes to capture specific errors and take 
appropriate actions in the business process based on those errors. OnFault Groups allow you to add 
business process logic to handle specific and general error conditions. If you do not use OnFault 
Groups, your business process will quit on the step where the error occurs with no error handling.

Business Process Version Management
Sterling Integrator uses version management for implementing business process. As you make 
changes to an existing business process and create variations of that business process, you need to 
be sure that the business process that runs is the appropriate version.

The first time you check in a business process, the data you enter creates a business process 
definition—a uniquely named copy of the process that is stored in Sterling Integrator. The business 
process stored in Sterling Integrator is independent of any .bp file of the process that you save in a 
local directory. 

At any time, you can open an existing business process, modify and save it, and then either check 
in the new version to Sterling Integrator, or save the modified copy of the process in Sterling 
Integrator as a new process altogether. All previously checked-in versions of business processes 
continue to be stored in Sterling Integrator. This enables you to revert to using an older version 
should the need arise.

Use the following workflow to update your business process with error handling:

1. Check Out the Business Process on page 60
2. Edit the Business Process on page 60
3. Check In Your Business Process on page 62
4. Submit and Monitor Your Sterling Integrator Business Process on page 63
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Check Out the Business Process
When you check out an existing business process with the Source Manager, you lock the business 
process and prevent other users from modifying it at the same time.

Use the following procedure to check out your existing business process that copies a file from 
Sterling Integrator to Connect:Direct:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type the existing business process 

name in the Process Name box and click Go.
4. Click Source Manager for your business process.
5. On the Source Manager page, click check out for the version of the business process you want 

to check out.
6. Click OK in the dialog box to lock the file for editing.
7. In the File Download dialog box, click Save to save a copy of the business process to your 

local file system.
8. In the Save As dialog box, navigate to the directory where you want to save the business 

process, type the business process file name in the File name box, and click Save.

Edit the Business Process
In this scenario, you add an OnFault Group to handle errors in your business process.

Use the following procedure to edit the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the BPML stencil is not visible in the GPM, navigate to the View menu and select Stencil > 

BPML. 
This will add the BPML stencil to the GPM.

4. If the Connect:Direct stencil is not visible in the GPM, navigate to the View menu and select 
Stencil > Applications > Sterling Commerce > Connect:Direct. 
This will add the Connect:Direct stencil to the GPM.

5. From the File menu, select Open, navigate to the existing business process file and click Open.
6. Drag and drop the following icons from the BPML stencil into the Business Process window:

Sequence Start

OnFault Group

Sequence End
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7. To arrange and link the icons:
a. Click the link between the CD Server Begin Session Service icon and CD Server CopyTo 

Service icon and press Delete to remove the link.
b. Place the Sequence Start icon between the CD Server Begin Session Service icon and the 

CD Server CopyTo Service icon.
c. Click the arrow on the right side of the CD Server Begin Session Service icon and drag it 

to the arrow on the left side of the Sequence Start icon.
d. Click the arrow on the right side of the Sequence Start icon and drag it to the arrow on the 

left side of the CD Server CopyTo Service icon.
e. Click the link between the CD Server End Session Service icon and End icon and press 

Delete to remove the link.
f. Place the Sequence End icon between the CD Server End Session Service icon and the 

End icon.
g. Click the arrow on the right side of the End Sequence icon and drag it to the arrow on the 

left side of the End icon.
h. Place the OnFault Group icon below and to the right of the Begin Sequence icon.
i. Click the arrow on the right side of the Begin Sequence icon and drag it to the arrow on 

the left side of the OnFault Group.

8. Configure the OnFault Group using the following procedure:
a. Double-click the OnFault Group icon. This opens the Property Editor window and Layers 

window.
The OnFault element contains a fault handling activity. If an error occurs between the 
Sequence Start and Sequence End, the fault handling activity is invoked. In this example, 
the fault handling activity contains a CD Server End Session Service to ensure that the 
session ends if there is an error. If the OnFault Group is not included in this business 
process and an error occurs on the CD Server CopyTo Service, the business process would 
stop before the CD Server End Service and the session would stay active.

b. In the Layers Window, click the Default icon to open the fault handling activity in the 
business process window.
The business process window contains an OnFault Start icon and an OnFault End icon.

c. In the Service Editor-CD Server Begin Session Service window, select 
CDServerBeginSession from the Config drop-down list. 
The Message To Service tab is displayed.
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d. Drag and drop the CD Server End Session icon from the Connect:Direct stencil into the 
Business Process window and place it between the OnFault Start icon and the OnFault 
End icon.

e. Click the arrow on the right side of the OnFault Start icon and drag it to the arrow on the 
left side of the CD Server End Session Service icon.

f. Click the arrow on the right side of the CD Server End Session Service icon and drag it to 
the arrow on the left side of the OnFault End icon.

g. Double-click the CD Server End Session Service icon.
h. In the Service Editor-CD Server End Session Service window, select 

CDServerEndSession from the Config drop-down list.
In this step you specify the pre-defined CDServerEndSession configuration to use for the 
CD Server End Session Service. You can override configuration values in the Service 
Editor.

i. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 
select the Use XPATH? box.
The SessionToken value in the CD Server End Session Service ensures that this service 
closes the session initiated by the CD Server Begin Session Service.

9. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

10. On the Save dialog box, type your business process file name in the File Name box and click 
Save. Remember where you save this file.

Check In Your Business Process
Use the following procedure to check the revised business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type your business process name 

in the Process Name box and click Go!.

Note: To see a sample business process, refer to Sample Business Process: Add Error Handling on page 
111.
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4. Click Source Manager for your business process.
5. On the Source Manager page, select Go! to Check in an updated definition for this business 

process.
6. On the Process Definition Check-in page, click Browse and navigate to the business process 

file that you saved in step 10 of the previous procedure.
7. Type a short description of the business process changes in the Description box and click 

Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full.
11. Set the Recovery Level to Auto Resume and click Next.

If Sterling Integrator stops responding during a copy transaction and the recovery level is set 
to Auto Resume, the business process resumes automatically at the next Sterling Integrator 
start up.

12. On the Deadline Settings page, click Next.
13. On the Life Span page, click Next.

14. On the Set Default Version page, select the updated version of the business process.
15. On the Confirm page, select the Enable Business Process box.
16. Click Finish.

Submit and Monitor Your Sterling Integrator Business 
Process

Submit and monitor your revised Sterling business process to verify that it still works. The OnFault 
Group should not execute and the execution results should be the same as they were before you 
modified the business process.

In order to test the OnFault logic, you must cause the CD Server CopyTo Service to fail. 

Use the following procedure to test the revised business process OnFault logic:

1. Modify the Connect:Direct User ID in Connect:Direct. In the Functional Authorities, set the 
Download directory for the account to a nonexistent directory.

2. Submit the revised business process. 

The CD Server CopyTo Service fails and the business process executes the OnFault logic.

The CD Server End Session Service contained in the fault handling logic ends the 
Connect:Direct session.

Use the following procedure to submit your Sterling Integrator business process:

1. Log in to Sterling Integrator.
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2. From the Business Process menu, select Manager.
3. In the Search pane, type your business process name in the Process Name box and click Go!.
4. On the Business Process Manager page, click Execution Manager.
5. On the Execution Manager page, click Execute for the revised business process to launch the 

Execute Business Process Input dialog box.
6. Click Browse and navigate to your source file on your local system and click Open. 

7. Click Go! to submit your business process. The Execute Business Process page is displayed. 
8. Close the Execute Business Process page.

Monitor with Sterling Integrator
Use the following procedure to monitor your business process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process name in the 

Business Processes list and click Go!.
The Monitor page displays the following information:

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number

Name The business process name

State The current state of the business process
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If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.
3. Click the ID number to see details about the business process execution.

The Business Process Detail page displays the following information for each step:

4. Check the Status and Advanced Status for the Connect:Direct Server CopyTo Service. 
The CopyTo service generates an error and reports Check the file permissions or path on 
Remote Connect:Direct.

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step
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5. The next step in the Business Process Detail is the Decision Engine Service. 
This step is invoked by the error handling of the OnFault Group in the business process. The 
Status for this step indicates that the Decision Engine Service is successfully able to invoke the 
OnFault error handling.

6. The last step in the Business Process Detail is the CD Server End Session Service. 
The Status for this step indicates that it successfully closes the Connect:Direct session.

Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your revised Sterling Integrator to 
Connect:Direct business process.

If the Connect:Direct process is unsuccessful, the Select Statistics detail will report the following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Note: You can also monitor your business processes from the Business Processes menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.

Attribute Value

Message ID LSFN001 (if Connect:Direct is installed on a Windows system)

Message Text Unable to open file <your destination file> - Fdbk=3

Destination File <revised download directory>\<your destination file>
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Add Secure+ Option

The Connect:Direct Secure+ Option provides enhanced security for Connect:Direct and Sterling 
Integrator Connect:Direct Server adapter. When you enable the Secure+ Option, the files are 
encrypted using SSL or TLS during transfer.

This chapter describes how to configure and enable Secure+ Option on Connect:Direct and the 
Sterling Integrator Connect:Direct Server adapter.

The Secure+ Option for Connect:Direct is an optional component. Your Connect:Direct node must 
be licensed for Secure+ Option and the Secure+ Option must be installed on your system. This 
workflow assumes you have the required certificates for implementing Secure+. You can use the 
Sterling Certificate Wizard to generate certificate signing requests, self-signed certificates, key 
certificate files and certificate chains. For more information, refer to Appendix D, Certificate 
Wizard.

Use the following workflow to implement Secure+:

✦ Configure Connect:Direct Secure+ Option on page 67
✦ Configure Secure+ Option in Sterling Integrator on page 68
✦ Copy a File Using Connect:Direct Secure+ Option on page 70
✦ Copy a File Using Your Sterling Integrator Business Process on page 70

Configure Connect:Direct Secure+ Option
Use the following procedure to configure Secure+ Option with Connect:Direct:

1. Launch the Connect:Direct Secure+ Admin Tool.
If the Secure+ Admin Tool has not been initialized, follow the on-screen instructions to 
complete the initialization.

2. From the File menu, select Sync with Netmap. The Available Netmaps dialog box is 
displayed.

3. Select the netmap to open and click Sync. The Select Netmap Entries to Add dialog box is 
displayed.
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4. Click Add All.
The Select Parameters File Entries to Delete dialog box is displayed.

5. Click Skip to close the parameters file without deleting any entries. 
The Secure+ Option parameters file is populated and the Secure+ Admin Tool Main window 
displays remote node records in the parameters file including any records you added from the 
network map, including the Sterling Integrator Connect:Direct Server adapter node. 

6. Double-click the Sterling Integrator Connect:Direct Server adapter node. The Edit Record 
dialog box displays the Security Options tab, the node name, and the type of node. 

7. On the Security Options tab, select Enable TLS Protocol or Enable SSL Protocol depending on 
which protocol you are using.

8. On the Node or Copy Statement Override pane, select Enable Override.
This allows you to configure the TLS/SSL protocol at the node level.

9. Click the TLS/SSL Protocol tab. The TLS/SSL Options dialog box is displayed. 
10. Click Browse next to the Trusted Root Certificate File box, navigate to the Connect:Direct 

Server adapter root certificate, and double-click the file to select it. 
11. Click Browse next to the Key Certificate File box, navigate to the key certificate, and 

double-click the file to select it. The Certificate Passphrase dialog box is displayed.
12. Type the passphrase you specified when you created your private key in the Certificate 

Passphrase box. 
13. Click OK. The Certificate File box is populated with the certificate file name and location.
14. Highlight the cipher suites to enable in the Available list and click Add. 
15. If necessary, use the Up and Down buttons to reorder the cipher suites. Place the cipher suites 

in order of preference. 
16. Click OK to close the Edit Record dialog box and update the parameters file.

Configure Secure+ Option in Sterling Integrator
Use the following procedure to check in the Connect:Direct root CA certificate with Sterling 
Integrator:

1. From the Trading Partner menu, select Digital Certificates > CA.
2. In the Check in New Certificate pane, click Go!.
3. On the Get Certificate page, click Browse and navigate to the Connect:Direct CA root 

certificate.
4. On the Choose File dialog box, click Open. The dialog box closes and returns you to the Get 

Certificate page.
5. Click Next to advance to the Naming page.
6. Make a note of the Certificate Name and click Next.
68 Connect:Direct Server Adapter User Guide



Configure Secure+ Option in Sterling Integrator
7. On the Confirm page, click Finish.

Use the following procedure to check in the Key Certificate file for your Connect:Direct Server 
adapter:

1. From the Trading Partner menu, select Digital Certificates > System.
2. In the Check in pane, click Go! for Key Certificate.
3. On the Key Certificate Data page, type a descriptive name in the Certificate Name box.
4. In the Private Key Password box, type the passphrase associated with the Sterling Integrator 

Connect:Direct Server adapter private key.
You created this passphrase when you generated your CSR.

5. Click Browse and navigate to the private key file.
6. On the Choose File dialog box, click Open. The dialog box closes and you return to the Key 

Certificate Data page.
7. Click Next to advance to the Validate When Used page.
8. Click next to advance to the Confirm Page.
9. Click Finish.

Modify the Connect:Direct Server Adapter Configuration to Use Secure+

Note: You can use a self-signed certificate that you create in Sterling Integrator or Certificate 
Wizard as your system certificate for testing purposes. Self-signed certificates are not 
recommended for production use.

Field Value to Enter Description

Encryption using 
Secure+

Enabled. Whether Secure+ is enabled. Required. Valid values are 
Enabled and Disabled. Default is Disabled.

Enable Netmap Node 
Override 

Select No for this scenario. 
Configure Secure+ at the 
Connect:Direct Server 
adapter level rather than the 
node level.

If Yes, specifies that remote node netmap security settings 
override the adapter security settings. Required. Valid values 
are Yes and No. Default is No. 

CA Certificates Select the CA certificate you 
checked in above. 
This is the CA root certificate 
for the Connect:Direct server.

Drop-down menu that contains a list of trusted Certificate 
Authority public certificates. Only displayed if "Encryption 
using Secure+" is enabled. Required if Encryption using 
Secure+ is enabled. Valid values are all CA certificates in this 
installation of your application. 

System Certificate Select the System certificate 
you checked in above.
This is the certificate for the 
Connect:Direct Server 
adapter node.

List of private keys and public certificates signed by the 
trading partner trusted certificate authority. This represents 
the certificate for the local node (this adapter). Only displayed 
if Encryption using Secure+ is enabled. Required if 
Encryption using Secure+ is enabled. Valid values are all 
system certificates in this installation of your application. 
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Copy a File Using Connect:Direct Secure+ Option
Secure+ is configured and enabled on Connect:Direct and Sterling Integrator. You do not have to 
modify your Connect:Direct process to encrypt the file with Secure+.

Submit your existing Connect:Direct process to copy a file to Sterling Integrator. You can monitor 
the process results from Connect:Direct or Sterling Integrator as before.

Copy a File Using Your Sterling Integrator Business Process
You do not have to modify your Sterling Integrator business process to encrypt the file with 
Secure+.

Certificate Common 
Name

If you want to verify the 
Common Name of the 
Connect:Direct CA 
certificate, specify it here.
This feature is only available 
if you use signed certificates.
Coordinate this with the 
remote Connect:Direct 
administrator.

Value to be compared with the Common Name (CN) field 
from the remote node's certificate during TLS/SSL 
handshake in order to enhance certificate authentication. 
Only displayed if Encryption using Secure+ is enabled. May 
be overridden at the node level. 
Note: To see the actual CNs being compared during the 
handshake, set the Perimeter Services logging level to ALL. 

Cipher Suites Select which cipher suites 
you wish to use.
Coordinate this list with the 
remote Connect:Direct 
administrator.
Best practice is to list cipher 
suites in strongest to weakest 
order.

Indicates cipher suites available to support varying 
encryption levels. Multiple selections allowed. Selections can 
be rank ordered. Only displayed if "Encryption using 
Secure+" is enabled. Required if "Encryption using Secure+" 
is enabled. Valid values are all available cipher suites in this 
installation of your application. 

SSL or TLS Select SSL or TLS.
Coordinate this choice with 
the remote Connect:Direct 
administrator.

Indicates if Secure+ is enabled using SSL or TLS. Only 
displayed if "Encryption using Secure+" is enabled. Required 
if "Encryption using Secure+" is enabled. Valid values are 
SSL and TLS. Default is SSL. 

Require Client 
Authentication

Select Yes or No for client 
authentication.
Coordinate this choice with 
the Connect:Direct 
administrator.

Indicates whether authentication occurs at the client level. 
Valid values are: 
Yes 
No 

Field Value to Enter Description
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Submit and monitor your revised Sterling business process that contains the OnFault Group to 
verify that it still works. The OnFault Group should not execute and the execution results should be 
the same as they were before you modified the business process.
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Chapter 10

Use Sterling Integrator to Submit a
Connect:Direct Process

This chapter describes how to modify the Sterling Integrator business process to submit a process 
on the Connect:Direct node after the file is copied. The Connect:Direct process copies the file 
received from Sterling Integrator to a z/OS system.

Use the following workflow to submit a Connect:Direct process with Sterling Integrator:

✦ Create Connect:Direct Process on page 73
✦ Check Out the Business Process on page 74
✦ Edit the Business Process on page 74
✦ Check In Your Business Process on page 76
✦ Submit and Monitor Your Sterling Integrator Business Process on page 76

Create Connect:Direct Process
Create a Connect:Direct process that copies the file received from the Sterling Integrator node to a 
Connect:Direct for z/OS system. This process is invoked by the Sterling Integrator business 
process. 

COPY2ZOS PROCESS 
SNODE=mainframeNode

STEP1 COPY 
FROM (
FILE=sourceFile
)
TO (
FILE=destinationFile
DISP=RPL
)

PEND
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Check Out the Business Process
When you check out an existing business process with the Source Manager, you lock the business 
process and prevent other users from modifying it at the same time. 

Use the following procedure to check out your business process that contains the OnFault Group 
from Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type your business process name 

in the Process Name box and click Go!.
4. Click Source Manager for your business process.
5. On the Source Manager page, click check out for the version of the business process you want 

to check out.
6. Click OK in the dialog box to lock the file for editing.
7. In the File Download dialog box, click Save to save a copy of the business process to your 

local file system.
8. In the Save As dialog box, navigate to the directory where you want to save the business 

process, type the business process file name in the File name box, and click Save.

Edit the Business Process
In this scenario, you add a CD Server Submit Service to the business process. The business process 
copies a file to the Connect:Direct server and then submits a process on that same server.

Use the following procedure to edit the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the Connect:Direct stencil is not visible in the GPM, navigate to the View menu and select 

Stencil > Applications > Sterling Commerce > Connect:Direct. 
This will add the Connect:Direct stencil to the GPM.

4. From the File menu, select Open, navigate to the CopyToCD.bp file and click Open.
5. Drag and drop the CD Server Submit Service icon from the Connect:Direct stencil into the 

Business Process window.
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6. To arrange and link the icons:
a. Click the link between the CD Server CopyTo Service icon and CD Server End Session 

Service icon and press Delete to remove the link.
b. Place the CD Server Submit Service icon between the CD Server CopyTo Service icon 

and the CD Server End Session Service icon.
c. Click the arrow on the right side of the CD Server CopyTo Service icon and drag it to the 

arrow on the left side of the CD Server Submit Service icon.
d. Click the arrow on the right side of the CD Server Submit Service icon and drag it to the 

arrow on the left side of the CD Server End Session Service icon.

7. Configure the CD Server Submit Service using the following procedure:
a. Double-click the CD Server Submit Service icon. This opens the Service Editor window.

The CD Server Submit Service acts like a Submit statement in a Connect:Direct process. 
Use this service to submit a Connect:Direct process on a remote Connect:Direct server.

b. In the Service Editor-CD Server Submit Service window, select CDServerSubmit from 
the Config drop-down list.
In this step you specify the pre-defined CDServerSubmit configuration to use for the CD 
Server Submit Service. You can override configuration values in the Service Editor.

c. Type the Connect:Direct process file name as the Value for RemoteProcessFile.
d. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 

select the Use XPATH? box.
The SessionToken value in the CD Server Submit Service ensures that this service submits 
the Connect:Direct process using the session initiated by the CD Server Begin Session 
Service.

8. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

9. On the Save dialog box, type the business process name in the File Name box and click Save. 
Remember where you save this file.

Note: To see a sample business process, refer to Sample Business Process: Submit a Connect:Direct 
Process on page 113.
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Check In Your Business Process
Use the following procedure to check the revised business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type the business process name in 

the Process Name box and click Go!.
4. Click Source Manager for the business process.
5. On the Source Manager page, select Go! to Check in an updated definition for this business 

process.
6. On the Process Definition Check-in page, click Browse and navigate to the business process 

file that you saved in step 9 of the previous procedure.
7. Type a short description of the updated business process in the Description box and click Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full.
11. Set the Recovery Level to Auto Resume and click Next.

If Sterling Integrator stops responding during a copy transaction and the recovery level is set 
to Auto Resume, the business process resumes automatically at the next Sterling Integrator 
start up.

12. On the Deadline Settings page, click Next.
13. On the Life Span page, click Next.
14. On the Set Default Version page, select the updated version of the business process.
15. On the Confirm page, select the Enable Business Process box.
16. Click Finish.

Submit and Monitor Your Sterling Integrator Business 
Process

Before you submit your revised Sterling business process, modify the Connect:Direct User ID in 
Connect:Direct. In the Functional Authorities, set the Download directory back to its original 
setting so that the CD Server CopyTo Service does not fail.

Use the following procedure to submit your Sterling Integrator business process:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
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3. In the Search pane, type the business process name in the Process Name box and click Go!.
4. On the Business Process Manager page, click Execution Manager.
5. On the Execution Manager page, click Execute for the revised business process to launch the 

Execute Business Process Input dialog box.
6. Click Browse and navigate to your source file on your local system and click Open. 

7. Click Go! to submit the business process. 
The Execute Business Process page is displayed. 

8. Close the Execute Business Process page.

Monitor with Sterling Integrator
Use the following procedure to monitor your business process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process in the Business 

Processes list and click Go!.
The Monitor page displays the following information:

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number
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If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.
3. Click the ID number to see details about the business process execution.

The Business Process Detail page displays the following information for each step:

4. The Status for the Connect:Direct Server Submit Service is Success. This indicates only that 
the Connect:Direct process was successfully submitted. It does not provide a completion status 
for the process. You must use the Connect:Direct Statistics to verify completion status for the 
process.

Name The business process name

State The current state of the business process

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step

Label Description
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5. The last step in the Business Process Detail is the CD Server End Session Service. The Status 
for this step indicates that it successfully closes the Connect:Direct session.

Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your revised Sterling Integrator to 
Connect:Direct business process.

If the Connect:Direct process is successfully submitted, the Select Statistics detail will report the 
following:

If the Connect:Direct process is not successfully submitted, refer to Troubleshooting on page 145.

If the Connect:Direct process completes successfully, the Select Statistics will report the following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Note: You can also monitor your business processes from the Business Processes menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.

Attribute Value

Message ID LSMG407I (if Connect:Direct is installed on a Windows system)

Message Text SUBMIT within a process step completed successfully

Source File <default process directory>\<Connect:Direct process file>

Attribute Value

Message ID LSMG252I (if Connect:Direct is installed on a Windows system)

Message Text A user process has completed successfully

Process Name Connect:Direct process name
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Chapter 11

Use Sterling Integrator to Start a
Connect:Direct Run Job

This chapter describes how to modify the Sterling Integrator business process to start a program on 
the Connect:Direct server using a Run Job after a file is copied. The Connect:Direct Server adapter 
does not verify the validity of the submitted program and does not wait for the submitted job to 
complete. The program runs as a separate process.

Use the following workflow to start a Connect:Direct Run Job from Sterling Integrator:

✦ Check Out the Business Process on page 81
✦ Edit the Business Process on page 82
✦ Check In Your Business Process on page 83
✦ Submit and Monitor Your Sterling Integrator Business Process on page 84

Check Out the Business Process
When you check out an existing business process with the Source Manager, you lock the business 
process and prevent other users from modifying it at the same time.

Use the following procedure to check out your business process that contains the CD Server Submit 
Service from Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type your business process name 

in the Process Name box and click Go!.
4. Click Source Manager for your business process.
5. On the Source Manager page, click check out for the version of the business process you want 

to check out.
6. Click OK in the dialog box to lock the file for editing.
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7. In the File Download dialog box, click Save to save a copy of the business process to your 
local file system.

8. In the Save As dialog box, navigate to the directory where you want to save the business 
process, type the business process file name in the File name box, and click Save.

Edit the Business Process
In this scenario, you replace the CD Server Submit Service with the CD Server Run Job Service in 
your business process. The business process copies a file to the Connect:Direct server and then 
starts a Connect:Direct Run Job on that server.

Use the following procedure to edit the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the Connect:Direct stencil is not visible in the GPM, navigate to the View menu and select 

Stencil > Applications > Sterling Commerce > Connect:Direct. 

This will add the Connect:Direct stencil to the GPM.
4. From the File menu, select Open, navigate to the business process file and click Open.
5. Drag and drop the CD Server Run Job Service icon from the Connect:Direct stencil into the 

Business Process window.
6. To arrange and link the icons:

a. Click the CD Server Submit Service icon and press Delete to remove it.
b. Place the CD Server Run Job Service icon between the CD Server CopyTo Service icon 

and the CD Server End Session Service icon.
c. Click the arrow on the right side of the CD Server CopyTo Service icon and drag it to the 

arrow on the left side of the CD Server Run Job Service icon.
d. Click the arrow on the right side of the CD Server Run Job Service icon and drag it to the 

arrow on the left side of the CD Server End Session Service icon.
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7. Configure the CD Server Run Job Service using the following procedure:
a. Double-click the CD Server Run Job Service icon. This opens the Service Editor window.

The CD Server Run Job Service acts like a Run Job statement in a Connect:Direct process. 
Use this service to start a Connect:Direct Run Job on a remote Connect:Direct server.

b. In the Service Editor-CD Server Run Job Service window, select CDServerRunJob from 
the Config drop-down list.
In this step you specify the pre-defined CDServerRunJob configuration to use for the CD 
Server Run Job Service. You can override configuration values in the Service Editor.

c. Type pgm(path/filename) desktop(yes) as the Value for Sysopts, where path is the full 
directory path and filename is the file name of the program or script you wish to run in the 
Run Job.

d. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 
select the Use XPATH? box.
The SessionToken value in the CD Server Run Job Service ensures that this service starts 
the Connect:Direct Run Job using the session initiated by the CD Server Begin Session 
Service.

8. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

9. On the Save dialog box, type the business process name in the File Name box and click Save. 
Remember where you save this file.

Check In Your Business Process
Use the following procedure to check the revised business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type the business process name in 

the Process Name box and click Go!.
4. Click Source Manager for your business process.
5. On the Source Manager page, select Go! to Check in an updated definition for this business 

process.
6. On the Process Definition Check-in page, click Browse and navigate to the business process 

file that you saved in step 9 of the previous procedure.
7. Type a short description of your business process in the Description box and click Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.

Note: To see a sample business process, refer to Sample Business Process: Start a Connect:Direct Run 
Job on page 115.
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10. Set the Event Reporting Level to Full.
11. Set the Recovery Level to Auto Resume and click Next.

If Sterling Integrator stops responding during a copy transaction and the recovery level is set 
to Auto Resume, the business process resumes automatically at the next Sterling Integrator 
start up.

12. On the Deadline Settings page, click Next.
13. On the Life Span page, click Next.
14. On the Set Default Version page, select the updated version of the business process.
15. On the Confirm page, select the Enable Business Process box.
16. Click Finish.

Submit and Monitor Your Sterling Integrator Business 
Process

Use the following procedure to submit your Sterling Integrator business process:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. In the Search pane, type your business process name in the Process Name box and click Go!.
4. On the Business Process Manager page, click Execution Manager.
5. On the Execution Manager page, click Execute for the revised business process to launch the 

Execute Business Process Input dialog box.
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6. Click Browse and navigate to the source file on your local system and click Open. 

7. Click Go! to submit the business process. 
The Execute Business Process page is displayed. 

8. Close the Execute Business Process page.
The program, application, or script runs on the Connect:Direct server.

Monitor with Sterling Integrator
Use the following procedure to monitor your business process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process name in the 

Business Processes list and click Go!.
The Monitor page displays the following information:

If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number

Name The business process name

State The current state of the business process
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3. Click the ID number to see details about the business process execution.
The Business Process Detail page displays the following information for each step:

4. The Status for the Connect:Direct Server Run Job Service is Success. This indicates only that 
the Connect:Direct Run Job successfully started. It does not provide a completion status for 
the application invoked by the Run Job.

5. The last step in the Business Process Detail is the CD Server End Session Service. The Status 
for this step indicates that it successfully closes the Connect:Direct session.

Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your revised Sterling Integrator to 
Connect:Direct business process.

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step

Note: You can also monitor your business processes from the Business Processes menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.
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If the Connect:Direct Run Job starts successfully, the Select Statistics detail will report the 
following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Attribute Value

Message ID LSMG400I (if Connect:Direct is installed on a Windows system)

Message Text A user RUNJOB step completed successfully

Source File pgm(path/filename) desktop(yes)
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Chapter 12

Use Sterling Integrator to Start a
Connect:Direct Run Task

This chapter describes how to modify your Sterling Integrator business process to start and wait on 
a program on the Connect:Direct server via a Run Task after the source file is copied. The program 
may be a program or script. The Connect:Direct Server adapter does not verify the validity of the 
submitted program, but it does wait for the submitted job to complete before moving to the next 
service in the business process. The program or script runs as a separate process.

Use the following workflow to start a Connect:Direct Run Task from Sterling Integrator:

✦ Check Out the Business Process on page 89
✦ Edit the Business Process on page 90
✦ Check In Your Business Process on page 91
✦ Submit and Monitor Your Sterling Integrator Business Process on page 92

Check Out the Business Process
When you check out an existing business process with the Source Manager, you lock the business 
process and prevent other users from modifying it at the same time.

Use the following procedure to check out your business process that contains the CD Server Run 
Job Service from Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type your business process name 

in the Process Name box and click Go!.
4. Click Source Manager for your business process.
5. On the Source Manager page, click check out for the version of the business process you want 

to check out.
6. Click OK in the dialog box to lock the file for editing.
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7. In the File Download dialog box, click Save to save a copy of the business process to your 
local file system.

8. In the Save As dialog box, navigate to the directory where you want to save the business 
process, type the business process file name in the File name box, and click Save.

Edit the Business Process
In this scenario, you replace the CD Server Run Job Service with the CD Server Run Task Service 
in your business process. The business process copies a file to the Connect:Direct server and then 
starts a Connect:Direct Run Task on that server. The business process waits for the Run Task to 
complete before the CD Server End Session Service terminates the Connect:Direct session.

Use the following procedure to edit the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the Connect:Direct stencil is not visible in the GPM, navigate to the View menu and select 

Stencil > Applications > Sterling Commerce > Connect:Direct. 
This will add the Connect:Direct stencil to the GPM.

4. From the File menu, select Open, navigate to the business process file and click Open.
5. Drag and drop the CD Server Run Task Service icon from the Connect:Direct stencil into the 

Business Process window.
6. To arrange and link the icons:

a. Click the CD Server Run Job Service icon and press Delete to remove it.
b. Place the CD Server Run Task Service icon between the CD Server CopyTo Service icon 

and the CD Server End Session Service icon.
c. Click the arrow on the right side of the CD Server CopyTo Service icon and drag it to the 

arrow on the left side of the CD Server Run Task Service icon.
d. Click the arrow on the right side of the CD Server Run Task Service icon and drag it to the 

arrow on the left side of the CD Server End Session Service icon.
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7. Configure the CD Server Run Task Service using the following procedure:
a. Double-click the CD Server Run Task Service icon. This opens the Service Editor 

window.
The CD Server Run Task Service acts like a Run Task statement in a Connect:Direct 
process. Use this service to start a Connect:Direct Run Task on a remote Connect:Direct 
server and wait for it to complete before executing the next service in a business process.

b. In the Service Editor-CD Server Run Task Service window, select CDServerRunTask 
from the Config drop-down list.
In this step you specify the pre-defined CDServerRunTask configuration to use for the CD 
Server Run Task Service. You can override configuration values in the Service Editor.

c. Type pgm(path/filename) desktop(yes) as the Value for SystemOpts, where path is the full 
directory path and filename is the file name of the program or script you wish to run in the 
Run Task.

d. Type //BeginSessionResults/SessionToken/node() as the Value for SessionToken and 
select the Use XPATH? box.
The SessionToken value in the CD Server Run Task Service ensures that this service starts 
the Connect:Direct Run Task using the session initiated by the CD Server Begin Session 
Service.

8. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

9. On the Save dialog box, type the business process file name in the File Name box and click 
Save. Remember where you save this file.

Check In Your Business Process
Use the following procedure to check the revised business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type the business process name in 

the Process Name box and click Go!.
4. Click Source Manager for your business process.
5. On the Source Manager page, select Go! to Check in an updated definition for this business 

process.
6. On the Process Definition Check-in page, click Browse and navigate to the business process 

file that you saved in step 9 of the previous procedure.
7. Type a short description of your business process in the Description box and click Next.

Note: To see a sample business process, refer to Sample Business Process: Start a Connect:Direct Run 
Task on page 117.
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8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full.
11. Set the Recovery Level to Auto Resume and click Next.

If Sterling Integrator stops responding during a copy transaction and the recovery level is set 
to Auto Resume, the business process resumes automatically at the next Sterling Integrator 
start up.

12. On the Deadline Settings page, click Next.
13. On the Life Span page, click Next.
14. On the Set Default Version page, select the updated version of the business process.
15. On the Confirm page, select the Enable Business Process box.
16. Click Finish.

Submit and Monitor Your Sterling Integrator Business 
Process

Use the following procedure to submit your Sterling Integrator business process:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. In the Search pane, type your business process name in the Process Name box and click Go!.
4. On the Business Process Manager page, click Execution Manager.
5. On the Execution Manager page, click Execute for the revised business process to launch the 

Execute Business Process Input dialog box.
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6. Click Browse and navigate to the source file on your local system and click Open. 

7. Click Go! to submit the business process. The Execute Business Process page is displayed. 
8. Close the Execute Business Process page.

Monitor with Sterling Integrator
Use the following procedure to monitor your business process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process in the Business 

Processes list and click Go!.
The Monitor page displays the following information:

If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number

Name The business process name

State The current state of the business process
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3. Click the ID number to see details about the business process execution.
The Business Process Detail page displays the following information for each step:

The Status for the Connect:Direct Server Run Task Service is not reported until the application 
or script completes. The Business Process Detail screen shows that the Connect:Direct Server 
Run Task Service is In progress...

4. When you close the application or script, The CD Server Run Task Service completes and the 
last step in the business process, the CD Server End Session Service, terminates the 
Connect:Direct session.

Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your revised Sterling Integrator to 
Connect:Direct business process.

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step

Note: You can also monitor your business processes from the Business Processes menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.
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If the Connect:Direct Run Task completes successfully, the Select Statistics detail will report the 
following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Attribute Value

Message ID LSMG402 (if Connect:Direct is installed on a Windows system)

Message Text A user RUNTASK step completed. Exit code = 0

Source File pgm(path/filename) desktop(yes)
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Chapter 13

Hide the Connect:Direct Password in the
Business Process

This chapter describes how to hide the value of the user password in your business process. Modify 
your Sterling Integrator business process by adding an Obscure Data - Process Data Values Service 
before the CD Server Begin Session Service.

Use the following workflow to hide the Connect:Direct password in the business process:

✦ Configure the Obscure Data - Process Data Values Service on page 97
✦ Check Out the Business Process on page 98
✦ Edit the Business Process on page 98
✦ Check In Your Business Process on page 100
✦ Submit and Monitor Your Sterling Integrator Business Process on page 100

Configure the Obscure Data - Process Data Values Service
Use the following procedure to configure the Obscure Data - Process Data Values Service:

1. Log in to Sterling Integrator.
2. From the Deployment menu, select Services > Configuration.
3. On the Services Configuration page, click Go! in the Create New Service pane.
4. In the Service Type box, type Obscure Data - Process Data Values and click Next.

5. On the Name page, in the Name box, type CDClientObscureParameter.
6. In the Description box, type a short description of what you are obscuring and click Next.
7. On the Parameters page, in the first Parameter Name box, type the Connect:Direct User ID.

Note: Alternately, you can navigate to Obscure Data - Process Data Values by clicking one of the 
navigation buttons next to the Service Type box.
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8. In the first Parameter Value box, type the password for the Connect:Direct User ID and click 
Next.

9. On the Confirm page, click Finish.

Check Out the Business Process
When you check out an existing business process with the Source Manager, you lock the business 
process and prevent other users from modifying it at the same time.

Use the following procedure to check out your business process that contains the CD Server Run 
Task Service from Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type your business process name 

in the Process Name box and click Go!.
4. Click Source Manager for your business process.
5. On the Source Manager page, click check out for the version of the business process you want 

to check out.
6. Click OK in the dialog box to lock the file for editing.
7. In the File Download dialog box, click Save to save a copy of the business process to your 

local file system.
8. In the Save As dialog box, navigate to the directory where you want to save the business 

process, type the business process file name in the File name box, and click Save.

Edit the Business Process
In this scenario, add the Obscure Data - Process Data Values to your business process. The Obscure 
Data - Process Data Values retrieves the remote password from the CDClientObscureParameter 
configuration. The CD Server Begin Session Service gets the remote password from the Obscure 
Data - Process Data Value. The remote password is not revealed in the business process.

Use the following procedure to edit the Sterling Integrator business process:

1. Log in to Sterling Integrator and launch the Graphical Process Modeler from the Home screen.
2. Enter your Sterling Integrator User ID and password in the Log In dialog box.
3. If the All Services stencil is not visible in the GPM, navigate to the View menu and select 

Stencil > All Services. 
This will add the All Services stencil to the GPM.

4. From the File menu, select Open, navigate to your business process file and click Open.
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5. Drag and drop the Obscure Data - Process Data Values icon from the Connect:Direct stencil 
into the Business Process window.

6. To arrange and link the icons:
a. Click the arrow between the start icon and the CD Server Begin Session Service icon and 

press Delete to remove it.
b. Place the Obscure Data - Process Data Values icon between the start icon and the CD 

Server Begin Session Service icon.
c. Click the arrow on the right side of the start icon and drag it to the arrow on the left side of 

the Obscure Data - Process Data Values icon.
d. Click the arrow on the right side of the Obscure Data - Process Data Values icon and drag 

it to the arrow on the left side of the CD Server Begin Session Service icon.

7. Configure the Obscure Data - Process Data Values using the following procedure:
a. Double-click the Obscure Data - Process Data Values icon. This opens the Service Editor 

window.
b. In the Service Editor-Obscure Data - Process Data Values window, select 

CDClientObscureParameter from the Config drop-down list.
In this step you specify the CDClientObscureParameter configuration to use for the 
Obscure Data - Process Data Values. You can override configuration values in the Service 
Editor.

8. Edit the CD Server Begin Session Service using the following procedure:
a. Double-click the CD Server Begin Session Service icon.
b. Type revealObscured(CDUserID) as the Value for the RemotePasswd and select the Use 

XPATH? box. CDUserID is the Connect:Direct User ID. 
c. Select Yes as the Value for UsingObscuredPasswd.

9. From the File menu, select Save. In the Validate dialog box, click Yes to validate the business 
process.

10. On the Save dialog box, type your business process file name in the File Name box and click 
Save. 
Remember where you save this file.

Note: To see a sample business process, refer to Sample Business Process: Hide the Connect:Direct 
Password on page 119.
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Check In Your Business Process
Use the following procedure to check the revised business process into Sterling Integrator:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. On the Business Process Manager page, in the Search pane, type your business process name 

in the Process Name box and click Go!.
4. Click Source Manager for your business process.
5. On the Source Manager page, select Go! to Check in an updated definition for this business 

process.
6. On the Process Definition Check-in page, click Browse and navigate to your business process 

file that you saved in step 10 of the previous procedure.
7. Type Added Obscure Data - Process Data Values to hide password in the Description box and 

click Next.
8. On the Process Levels page, select the Set onfault processing check box.
9. Set the Persistence Level to Full.
10. Set the Event Reporting Level to Full.
11. Set the Recovery Level to Auto Resume and click Next.

If Sterling Integrator stops responding during a copy transaction and the recovery level is set 
to Auto Resume, the business process resumes automatically at the next Sterling Integrator 
start up.

12. On the Deadline Settings page, click Next.
13. On the Life Span page, click Next.
14. On the Set Default Version page, select the updated version of the business process.
15. On the Confirm page, select the Enable Business Process box.
16. Click Finish.

Submit and Monitor Your Sterling Integrator Business 
Process

Use the following procedure to submit your Sterling Integrator business process:

1. Log in to Sterling Integrator.
2. From the Business Process menu, select Manager.
3. In the Search pane, type your business process in the Process Name box and click Go!.
4. On the Business Process Manager page, click Execution Manager.
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5. On the Execution Manager page, click Execute for the revised business process to launch the 
Execute Business Process Input dialog box.

6. Click Browse and navigate to the source file on your local system and click Open. 

7. Click Go! to submit your business process. 
The Execute Business Process page is displayed. 

8. Close the Execute Business Process page.
The application or script runs on the Connect:Direct server.

Monitor with Sterling Integrator
If you modify your business process with the Obscure Data - Process Data Values correctly, the 
business process execution results will be unchanged.

Use the following procedure to monitor your business process with Sterling Integrator:

1. From the Business Process menu, select Monitor > Advanced Search > Business Processes.
2. In the Search Using Business Process Name pane, select your business process in the Business 

Processes list and click Go!.
The Monitor page displays the following information:

Label Description

Status Status of the business process—a green traffic light signals a successful execution

ID The business process ID number
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If the Status indicates unsuccessful execution, refer to Troubleshooting on page 145.
3. Click the ID number to see details about the business process execution.

The Business Process Detail page displays the following information for each step:

4. The Status for the Connect:Direct Server Run Task Service is not reported until the application 
or script completes. The Business Process Detail screen shows that the Connect:Direct Server 
Run Task Service is In progress...

Name The business process name

State The current state of the business process

Label Description

Step The business process step number

Service The Sterling Integrator service name used in the step

Status The status of the step

Advanced Status Additional status information

Started The time and date the step started

Ended The time and date the step ended

Status Report A link to the status report for the step

Document A link to documents in use by the step

Instance Data A link to process data for the step

Label Description
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5. When you close the application or script, The CD Server Run Task Service completes and the 
last step in the business process, the CD Server End Session Service, terminates the 
Connect:Direct session.

Monitor with Connect:Direct
You can use the Connect:Direct Select Statistics to monitor your revised Sterling Integrator to 
Connect:Direct business process.

If the Connect:Direct Run Task completes successfully, the Select Statistics detail will report the 
following:

If the Connect:Direct process is not successful, refer to Troubleshooting on page 145.

Note: You can also monitor your business processes from the Business Processes menu by navigating to 
Monitor > Advanced Search > Documents or Monitor > Advanced Search > Communication 
Sessions.

Attribute Value

Message ID LSMG402I (if Connect:Direct is installed on a Windows system)

Message Text A user RUNTASK step completed. Exit code = 0

Source File pgm(path/filename) desktop(yes)
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Appendix A

Sample Business Processes

Sample Business Process: Copy a File from Connect:Direct to 
Sterling Integrator

In this sample, copy a file from a Connect:Direct Server (PNODE) to a Sterling Integrator 
Connect:Direct Server adapter (SNODE). The Connect:Direct Server adapter invokes the 
ReceiveFromCD business process and passes the file to the business process.

In the sample business process, shown in BPML, the Get Document Information Service obtains 
file information about the primary document and places it into process data. You can add additional 
services to this business process to perform operations such as translating the file or copying the file 
to another server using FTP.

<process name = "ReceiveFromCD"> 
  <operation name="Get Document Information Service">
    <participant name="GetDocumentInfoService"/>
    <output message="GetDocumentInfoServiceTypeInputMessage">
      <assign to="." from="*"></assign>
    </output>
    <input message="inmsg">
      <assign to="." from="*"></assign>
    </input>
  </operation>

</process>
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Sample Business Process: Pull a File from Sterling Integrator 
to Connect:Direct

In this sample, shown in BPML, the Connect:Direct node (PNODE) pulls a file from a Sterling 
Integrator Connect:Direct Server adapter (SNODE). The Connect:Direct node connects to the 
Sterling Integrator Connect:Direct Server adapter which invokes the RespondToCD business 
process. This business process passes a document to the Connect:Direct Server adapter which sends 
the file back to the Connect:Direct node.

In the first operation of the RespondToCD business process, the File System Adapter collects 
(reads) a file from the Sterling Integrator local file system. This file becomes the primary document 
of the business process.

In the next operation of the business process, the CD Server BP Response Service passes the 
primary document back to the Connect:Direct node (PNODE).

<process name = "RespondToCD"> 
  <sequence>
    <operation name="File System Adapter">
      <participant name="CollectForCD"/>
      <output message="FileSystemInputMessage">
        <assign to="Action">FS_COLLECT</assign>
        <assign to="deleteAfterCollect">false</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <operation name="CD Server BP Response Service">
      <participant name="CDServerBPResponse"/>
      <output message="CDServerBPResponseServiceTypeInputMessage">
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>
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Sample Business Process: Copy a File from Sterling 
Integrator to Connect:Direct

In this sample, shown in BPML, the Sterling Integrator CopyToCD business process passes a 
document to the Connect:Direct Server adapter (PNODE) which copies the file to the 
Connect:Direct node (SNODE). The business process functions much like a Connect:Direct 
process.

The first operation uses the CD Server Begin Session Service to establish a connection to the remote 
Connect:Direct node, CDWIN. The local node name of the Connect:Direct Server adapter is 
SI50CD. The Begin Session Service uses the remote user ID of cduser to authenticate to the 
Connect:Direct server.

The second operation uses the CD Server CopyTo Service to copy the primary document to the 
remote Connect:Direct server. The destination file name is cd.txt.

The third operation uses the CD Server End Session Service to terminate the session with the 
Connect:Direct server.

<process name="CopyToCD">
  <sequence>
    <operation name="CD Server Begin Session Service">
      <participant name="CDServerBeginSession"/>
      <output message="CDServerBeginSessionServiceTypeInputMessage">
        <assign to="LocalCDNodeName">SI50CD</assign>
        <assign to="RemoteCDNodeName">CDWIN</assign>
        <assign to="RemotePasswd">xxxxxxxx</assign>
        <assign to="RemoteUserId">cduser</assign>
        <assign to="UsingObscuredPasswd">NO</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <operation name="CD Server CopyTo Service">
      <participant name="CDServerCopyTo"/>
      <output message="CDServerCopyToServiceTypeInputMessage">
        <assign to="RemoteFileName">cd.txt</assign>
        <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>
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 <operation name="CD Server End Session Service">
      <participant name="CDServerEndSession"/>
      <output message="CDServerEndSessionServiceTypeInputMessage">
        <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>
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Sample Business Process: Copy a File from Connect:Direct to 
Sterling Integrator

In this sample, shown in BPML, the Sterling Integrator CopyFromCD business process invokes the 
Connect:Direct Server adapter (PNODE) which copies the file from the Connect:Direct node 
(SNODE) back to the business process as the primary document. The business process functions 
much like a Connect:Direct process.

The first operation uses the CD Server Begin Session Service to establish a connection to the remote 
Connect:Direct node, CDWIN. The local node name of the Connect:Direct Server adapter is 
SI50CD. The Begin Session Service uses the remote user ID of cduser to authenticate to the 
Connect:Direct server.

The second operation uses the CD Server CopyFrom Service to copy the source file from the remote 
Connect:Direct server. The source file name is sample.txt.

The third operation uses the CD Server End Session Service to terminate the session with the 
Connect:Direct server.

<process name="CopyFromCD">
  <sequence>
    <operation name="CD Server Begin Session Service">
      <participant name="CDServerBeginSession"/>
      <output message="CDServerBeginSessionServiceTypeInputMessage">
        <assign to="LocalCDNodeName">SI50CD</assign>
        <assign to="RemoteCDNodeName">CDWIN</assign>
        <assign to="RemotePasswd">xxxxxxxx</assign>
        <assign to="RemoteUserId">cduser</assign>
        <assign to="UsingObscuredPasswd">NO</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <operation name="CD Server CopyFrom Service">
      <participant name="CDServerCopyTo"/>
      <output message="CDServerCopyFromServiceTypeInputMessage">
        <assign to="RemoteFileName">sample.txt</assign>
        <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>
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 <operation name="CD Server End Session Service">
      <participant name="CDServerEndSession"/>
      <output message="CDServerEndSessionServiceTypeInputMessage">
        <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

  </sequence>
</process>
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Sample Business Process: Add Error Handling
In this sample, shown in BPML, you add error handling to the Sterling Integrator business process 
you created that passes a document to the Connect:Direct Server adapter (PNODE) which copies 
the file to the Connect:Direct node (SNODE). The error handling ensures that the Connect:Direct 
session closes if an error is encountered during the session.

The onFault branch contains an instance of the CD Server End Session Service. If an error occurs 
after the Begin Session Service, the onFault logic is invoked and the End Session Service terminates 
the session with the Connect:Direct server.

<process name="CopyToCD">
  <sequence>
    <operation name="CD Server Begin Session Service">
      <participant name="CDServerBeginSession"/>
      <output message="CDServerBeginSessionServiceTypeInputMessage">
        <assign to="LocalCDNodeName">SI50CD</assign>
        <assign to="RemoteCDNodeName">CDWIN</assign>
        <assign to="RemotePasswd">xxxxxxxx</assign>
        <assign to="RemoteUserId">cduser</assign>
        <assign to="UsingObscuredPasswd">NO</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <sequence>
      <operation name="CD Server CopyTo Service">
        <participant name="CDServerCopyTo"/>
        <output message="CDServerCopyToServiceTypeInputMessage">
          <assign to="RemoteFileName">cd.txt</assign>
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <operation name="CD Server End Session Service">
        <participant name="CDServerEndSession"/>
        <output message="CDServerEndSessionServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>
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 <onFault>
        <operation name="CD Server End Session Service">
          <participant name="CDServerEndSession"/>
          <output message="CDServerEndSessionServiceTypeInputMessage">
            <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
            <assign to="." from="*"></assign>
          </output>
          <input message="inmsg">
            <assign to="." from="*"></assign>
          </input>
        </operation>

      </onFault>
    </sequence>
  </sequence>
</process>
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Sample Business Process: Submit a Connect:Direct Process
In this sample, shown in BPML, you modify the Sterling Integrator business process to submit a 
process on the Connect:Direct node after the file is copied. The Connect:Direct process copies the 
file received from Sterling Integrator to a Z/OS system.

The CD Server Submit Service is placed after the CD Server CopyTo Service. The Submit Service 
submits a Connect:Direct process called Copy2ZOS.cdp.

<process name="CopyToCD">
  <sequence>
    <operation name="CD Server Begin Session Service">
      <participant name="CDServerBeginSession"/>
      <output message="CDServerBeginSessionServiceTypeInputMessage">
        <assign to="LocalCDNodeName">SI50CD</assign>
        <assign to="RemoteCDNodeName">CDWIN</assign>
        <assign to="RemotePasswd">xxxxxxxx</assign>
        <assign to="RemoteUserId">cduser</assign>
        <assign to="UsingObscuredPasswd">NO</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <sequence name="Sequence Start">
      <operation name="CD Server CopyTo Service">
        <participant name="CDServerCopyTo"/>
        <output message="CDServerCopyToServiceTypeInputMessage">
          <assign to="RemoteFileName">cd.txt</assign>
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <operation name="CD Server Submit Service">
        <participant name="CDServerSubmit"/>
        <output message="CDServerSubmitServiceTypeInputMessage">
          <assign to="RemoteProcessFile">Copy2ZOS.cdp</assign>
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>
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<operation name="CD Server End Session Service">
        <participant name="CDServerEndSession"/>
        <output message="CDServerEndSessionServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

<onFault>
        <operation name="CD Server End Session Service">
          <participant name="CDServerEndSession"/>
          <output message="CDServerEndSessionServiceTypeInputMessage">
            <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
            <assign to="." from="*"></assign>
          </output>
          <input message="inmsg">
            <assign to="." from="*"></assign>
          </input>
        </operation>

      </onFault>
    </sequence>
  </sequence>
</process>
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Sample Business Process: Start a Connect:Direct Run Job
In this sample, shown in BPML, you modify the Sterling Integrator business process to start a 
program on the Connect:Direct server using a Run Job after a file is copied. The Connect:Direct 
Server adapter does not verify the validity of the submitted program and does not wait for the 
submitted job to complete. The program runs as a separate process.

The CD Server Run Job Service is placed after the CopyTo Service. The Run Job Service passes 
pgm(C:\Windows\notepad.exe) desktop(yes) to the remote Connect:Direct server via Sysopts. This 
causes the Windows Notepad application to run on the Connect:Direct server.

<process name="CopyToCD">
  <sequence>
    <operation name="CD Server Begin Session Service">
      <participant name="CDServerBeginSession"/>
      <output message="CDServerBeginSessionServiceTypeInputMessage">
        <assign to="LocalCDNodeName">SI50CD</assign>
        <assign to="RemoteCDNodeName">CDWIN</assign>
        <assign to="RemotePasswd">xxxxxxxx</assign>
        <assign to="RemoteUserId">cduser</assign>
        <assign to="UsingObscuredPasswd">NO</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <sequence name="Sequence Start">
      <operation name="CD Server CopyTo Service">
        <participant name="CDServerCopyTo"/>
        <output message="CDServerCopyToServiceTypeInputMessage">
          <assign to="RemoteFileName">cd.txt</assign>
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <operation name="CD Server Run Job Service">
        <participant name="CDServerRunJob"/>
        <output message="CDServerRunJobServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="Sysopts">pgm(C:\Windows\notepad.exe) desktop(yes)</assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>
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 <operation name="CD Server End Session Service">
        <participant name="CDServerEndSession"/>
        <output message="CDServerEndSessionServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

<onFault>
        <operation name="CD Server End Session Service">
          <participant name="CDServerEndSession"/>
          <output message="CDServerEndSessionServiceTypeInputMessage">
            <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
            <assign to="." from="*"></assign>
          </output>
          <input message="inmsg">
            <assign to="." from="*"></assign>
          </input>
        </operation>

      </onFault>
    </sequence>
  </sequence>
</process>
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Sample Business Process: Start a Connect:Direct Run Task
In this sample, shown in BPML, you modify your Sterling Integrator business process to start and 
wait on a program on the Connect:Direct server via a Run Task after the source file is copied. The 
program may be a program or script. The Connect:Direct Server adapter does not verify the validity 
of the submitted program, but it does wait for the submitted job to complete before moving to the 
next service in the business process. The program or script runs as a separate process.

The CD Server Run Task Service is placed after the CopyTo Service. The Run Task Service passes 
pgm(C:\Windows\notepad.exe) desktop(yes) to the remote Connect:Direct server via Sysopts. This 
causes the Windows Notepad application to run on the Connect:Direct server.

<process name="CopyToCD">
  <sequence>
    <operation name="CD Server Begin Session Service">
      <participant name="CDServerBeginSession"/>
      <output message="CDServerBeginSessionServiceTypeInputMessage">
        <assign to="LocalCDNodeName">SI50CD</assign>
        <assign to="RemoteCDNodeName">CDWIN</assign>
        <assign to="RemotePasswd">xxxxxxxx</assign>
        <assign to="RemoteUserId">cduser</assign>
        <assign to="UsingObscuredPasswd">NO</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <sequence name="Sequence Start">
      <operation name="CD Server CopyTo Service">
        <participant name="CDServerCopyTo"/>
        <output message="CDServerCopyToServiceTypeInputMessage">
          <assign to="RemoteFileName">cd.txt</assign>
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <operation name="CD Server Run Task Service">
        <participant name="CDServerRunTask"/>
        <output message="CDServerRunTaskServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="SystemOpts">pgm(C:\Windows\notepad.exe) desktop(yes)</assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>
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 <operation name="CD Server End Session Service">
        <participant name="CDServerEndSession"/>
        <output message="CDServerEndSessionServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

<onFault>
        <operation name="CD Server End Session Service">
          <participant name="CDServerEndSession"/>
          <output message="CDServerEndSessionServiceTypeInputMessage">
            <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
            <assign to="." from="*"></assign>
          </output>
          <input message="inmsg">
            <assign to="." from="*"></assign>
          </input>
        </operation>

      </onFault>
    </sequence>
  </sequence>
</process>
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Sample Business Process: Hide the Connect:Direct Password
In this sample, shown in BPML, you modify your Sterling Integrator business process by adding an 
Obscure Data - Process Data Values Service before the CD Server Begin Session Service to hide 
the value of the user password.

The first operation in the business process is Obscure Data - Process Data Values. This service 
works with the CD Server Begin Session Service so that the password for the remote 
Connnect:Direct User ID, cduser, is not revealed in the business process. The password is retrieved 
using the RemotePasswd parameter, which is set to revealObscured(cduser) in the Begin Session 
Service.

<process name="CopyToCD">
  <sequence>
    <operation name="Obscure Data - Process Data Values">
      <participant name="CDClientObscureParameter"/>
      <output message="ObscureParameterInputMessage">
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="." from="*"></assign>
      </input>
    </operation>

    <operation name="CD Server Begin Session Service">
      <participant name="CDServerBeginSession"/>
      <output message="CDServerBeginSessionServiceTypeInputMessage">
        <assign to="LocalCDNodeName">SI50CD</assign>
        <assign to="RemoteCDNodeName">CDWIN</assign>
        <assign to="RemotePasswd" from="revealObscured(cduser)"></assign>
        <assign to="RemoteUserId">cduser</assign>
        <assign to="UsingObscuredPasswd">YES</assign>
        <assign to="." from="*"></assign>
      </output>
      <input message="inmsg">
        <assign to="BeginSessionResults" from="*"></assign>
      </input>
    </operation>

    <sequence name="Sequence Start">
      <operation name="CD Server CopyTo Service">
        <participant name="CDServerCopyTo"/>
        <output message="CDServerCopyToServiceTypeInputMessage">
          <assign to="RemoteFileName">cd.txt</assign>
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>
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 <operation name="CD Server Run Task Service">
        <participant name="CDServerRunTask"/>
        <output message="CDServerRunTaskServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="SystemOpts">pgm(C:\Windows\notepad.exe) 
desktop(yes)</assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

<operation name="CD Server End Session Service">
        <participant name="CDServerEndSession"/>
        <output message="CDServerEndSessionServiceTypeInputMessage">
          <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
          <assign to="." from="*"></assign>
        </output>
        <input message="inmsg">
          <assign to="." from="*"></assign>
        </input>
      </operation>

      <onFault>
        <operation name="CD Server End Session Service">
          <participant name="CDServerEndSession"/>
          <output message="CDServerEndSessionServiceTypeInputMessage">
            <assign to="SessionToken" 
from="//BeginSessionResults/SessionToken/node()"></assign>
            <assign to="." from="*"></assign>
          </output>
          <input message="inmsg">
            <assign to="." from="*"></assign>
          </input>
        </operation>

      </onFault>
    </sequence>
  </sequence>
</process>
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Copy Options

There are many copy options available when you use the Connect:Direct Server CopyTo Service.

When you using the Sterling Integrator Connect:Direct Server adapter to copy a file to a remote 
Connect:Direct server, coordinate the copy options with the Connect:Direct administrator.

Settings for Connect:Direct Server CopyTo Service
When you configure the Connect:Direct Server CopyTo service, you must specify settings for the 
following fields in the Graphical Process Modeler:

Field Description Supported Remote 
Connect:Direct Platforms

Config Name of the service configuration. Required. All platforms

BinaryMode Specifies the mode for Connect:Direct File 
transfer. Optional. Valid values are: 
• Yes—simple binary mode
• No—(default) - text mode
• VB—a variable block binary transfer with 

Connect:Direct on z/OS

Yes—All platforms
No—All platforms
VB—z/OS platform
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CheckpointInterval Specifies the byte interval for checkpoint 
support, which allows restart of interrupted 
transmissions at the last valid checkpoint point, 
reducing the time it takes to retransmit the file. 
Optional. Valid value is number of bytes, in the 
format: nnnnnnnnnn.
Application stores checkpoint information for 30 
days, after which it is automatically purged.
If your database is corrupted, purge this 
checkpoint information by performing a cold 
restart. To do this, edit the adapter 
configuration Server Start Option parameter to 
Cold Start. Once you have performed the cold 
start, edit the adapter configuration to change 
the setting back to Warm Start. 
You can also purge the checkpoint information 
from the database manually.

All platforms

Compression Specifies that the data is to be compressed, 
which reduces the amount of data transmitted 
as the file is copied from one node to another. 
The file will be automatically decompressed at 
the destination. Optional. Valid values are 1-9. 
Increasing value indicates higher attempt at 
compression. Values greater than 2 may not 
result in further compression.

All platforms

Field Description Supported Remote 
Connect:Direct Platforms
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DCB Specifies Data Control Block (DCB), a group of 
attributes specified as name-value pairs 
separated by commas. One, some, or all 
values may be included. Pattern is name=value 
with comma between, as in the following 
example:
recordlength=200, blocksize=0, 
recordformat=FB, datasetorganization=PS, 
unittype=cart, expirationdate=06365, 
volumecount=99
Used only on z/OS platform. Optional. Valid 
attributes are: 
• recordlength
• blocksize
• recordformat
• datasetorganization
• expirationdate
• volumecount
• unittype
Note: More DCB attributes are available but 
only these are supported in Application. Any 
other attribute will cause the copy to fail. 
For more information, see the Connect:Direct 
for z/OS user documentation. 

z/OS platform

Disposition Specifies how the file gets created on the 
remote Connect:Direct server. Optional. Valid 
values are: 
• New—Specifies that the CopyTo service 

will create the destination file. The copy fails 
if the file exists.

• rpl—Specifies that the destination file name 
replaces any existing file or, if none exists, 
allocates a new file.

All platforms

LocalDocumentId A valid document ID for an existing document 
in Application. When this field is left blank, the 
primary document provided to the business 
process is used. Optional. 

All platforms

LocalFileNameLabel Specifies a label for the name of the local file. 
This file name label is provided to the remote 
Connect:Direct node for informational purposes 
only. Optional.

All platforms

Field Description Supported Remote 
Connect:Direct Platforms
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LocalFromCodePage Specifies a code page supported by Java VM. 
Used in conjunction with the value of the 
LocalToCodePage parameter. The 
Connect:Direct Server adapter will apply a 
code page conversion to a document before 
transferring it to a remote Connect:Direct 
Server. This parameter is only valid with the 
following conditions: 
• Code page specified is supported by the 

local Java VM
• Parameter LocalToCodePage is defined
• Text mode file transfer (BinaryMode =No)
Optional. Valid value is the name of a 
codepage supported by the local Java VM. 
For example: 
<assign 
to="LocalFromCodePage">Cp1251</assign> 
<assign 
to="LocalToCodePage">Cp1047</assign> 
This example will translate the local file from 
windows latin-1 to ibm ebcdic. See 
http://java.sun.com for a complete list of 
supported encodings. 

All platforms

LocalStripBlanks Specifies whether the Connect:Direct Server 
adapter will strip blanks from the end of records 
in a received remote file before creating a new 
document. This option is only valid for Text 
mode file transfers (BinaryMode = No). 
Optional. 
Valid value is Yes or No (default). 

All platforms

Field Description Supported Remote 
Connect:Direct Platforms
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LocalToCodePage Specifies a code page supported by Java VM. 
Used in conjunction with the value of the 
LocalFromCodePage parameter. The 
Connect:Direct Server adapter will apply a 
code page conversion to a document before 
transferring it to a remote Connect:Direct 
Server. This parameter is only valid with the 
following conditions: 
• Code page specified is supported by the 

local Java VM
• Parameter LocalFromCodePage is defined
• Text mode file transfer (BinaryMode =No)
Optional. Valid value is the name of a 
codepage supported by the local Java VM. 
For example: 
<assign 
to="LocalFromCodePage">Cp1251</assign> 
<assign 
to="LocalToCodePage">Cp1047</assign> 
This example will translate the local file from 
windows latin-1 to ibm ebcdic. See 
http://java.sun.com for a complete list of 
supported encodings. 

All platforms

LocalXlate Specifies if the Connect:Direct Server adapter 
is to perform ASCII to EBCDIC translation 
before copying a file to a remote 
Connect:Direct Server. This option is only valid 
for Text mode file transfers (BinaryMode = No). 
Optional. 
Valid value is Yes (default) or No. 

All platforms

CDRecordType Identifies to the remote Connect:Direct which 
class to process the service. For example: 
1 
Optional. For more information, see the 
Connect:Direct for z/OS user documentation. 

z/OS platform

RemoteFileName Name that should be given to the file that is 
copied to the remote Connect:Direct server. 
Required.

All platforms

Field Description Supported Remote 
Connect:Direct Platforms
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SessionToken Identifies an established session between two 
Connect:Direct nodes. Required. Valid value is 
an XML structure that includes the following 
elements: 
• SessionId
• ProcessNumber
• ProcessName
• SubmitDateTime
• RemoteCDNodeName
• RemoteUserId
• RemotePasswd
• PlexClass
• MaxRestartRetries
• RestartRetryInterval

All platforms

Sysopts Remote system operations to be implemented 
on the remote Connect:Direct node. Optional. 
For example (for copying to Connect:Direct 
Windows only): 
Datatype(text) xlate(yes) 
For more information, see your Connect:Direct 
documentation. 

All platforms
Format of Sysopts varies by 
platform.

Field Description Supported Remote 
Connect:Direct Platforms
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Settings for Connect:Direct Server CopyFrom Service
There are many copy options available when you use the Connect:Direct Server CopyFrom Service.

When you configure the Connect:Direct Server CopyFrom service, you must specify settings for 
the following fields in the Graphical Process Modeler:

Field Description Supported Remote 
Connect:Direct Platforms

Config Name of the service configuration. Required. All platforms

BinaryMode Specifies the mode for Connect:Direct File 
transfer. Optional. Valid values are: 
• Yes—simple binary mode
• No—(default) - text mode
• VB—a variable block binary transfer with 

Connect:Direct on z/OS

Yes—All platforms
No—All platforms
VB—z/OS platform

CheckpointInterval Specifies the byte interval for checkpoint 
support, which allows restart of interrupted 
transmissions at the last valid checkpoint point, 
reducing the time it takes to retransmit the file. 
Optional. Valid value is number of bytes, in the 
format: nnnnnnnnnn.
Application stores checkpoint information for 30 
days, after which it is automatically purged.
If your database is corrupted, purge this 
checkpoint information by performing a cold 
restart. To do this, edit the adapter 
configuration Server Start Option parameter to 
Cold Start. Once you have performed the cold 
start, edit the adapter configuration to change 
the setting back to Warm Start. 
You can also purge the checkpoint information 
from the database manually.

All platforms

Compression Specifies that the data is to be compressed, 
which reduces the amount of data transmitted 
as the file is copied from one node to another. 
The file will be automatically decompressed at 
the destination. Optional. Valid values are 1-9. 
Increasing value indicates higher attempt at 
compression. Values greater than 2 may not 
result in further compression.

All platforms

LocalDocumentName Name of the document in Application to which 
the remote file should be copied. Optional.

All platforms
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LocalFromCodePage Specifies a code page supported by Java VM. 
Used in conjunction with the value of the 
LocalToCodePage parameter. The 
Connect:Direct Server adapter will apply a 
code page conversion to a document before 
transferring it to a remote Connect:Direct 
Server. This parameter is only valid with the 
following conditions: 
• Code page specified is supported by the 

local Java VM
• Parameter LocalToCodePage is defined
• Text mode file transfer (BinaryMode =No)
Optional. Valid value is the name of a 
codepage supported by the local Java VM. 
For example: 
<assign 
to="LocalFromCodePage">Cp1251</assign> 
<assign 
to="LocalToCodePage">Cp1047</assign> 
This example will translate the local file from 
windows latin-1 to ibm ebcdic. See 
http://java.sun.com for a complete list of 
supported encodings. 

All platforms

LocalStripBlanks Specifies whether the Connect:Direct Server 
adapter will strip blanks from the end of records 
in a received remote file before creating a new 
document. This option is only valid for Text 
mode file transfers (BinaryMode = No). 
Optional. 
Valid value is Yes or No (default). 

All platforms

Field Description Supported Remote 
Connect:Direct Platforms
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LocalToCodePage Specifies a code page supported by Java VM. 
Used in conjunction with the value of the 
LocalFromCodePage parameter. The 
Connect:Direct Server adapter will apply a 
code page conversion to a document before 
transferring it to a remote Connect:Direct 
Server. This parameter is only valid with the 
following conditions: 
• Code page specified is supported by the 

local Java VM
• Parameter LocalFromCodePage is defined
• Text mode file transfer (BinaryMode =No)
Optional. Valid value is the name of a 
codepage supported by the local Java VM. 
For example: 
<assign 
to="LocalFromCodePage">Cp1251</assign> 
<assign 
to="LocalToCodePage">Cp1047</assign> 
This example will translate the local file from 
windows latin-1 to ibm ebcdic. See 
http://java.sun.com for a complete list of 
supported encodings. 

All platforms

LocalXlate Specifies if the Connect:Direct Server adapter 
is to perform ASCII to EBCDIC translation 
before creating a new document from the 
received remote file. This option is only valid for 
Text mode file transfers (BinaryMode = No). 
Optional. 
Valid value is Yes (default) or No. 

All platforms

RemoteFileName Name of the file that should be copied from the 
remote Connect:Direct server. Enter the legal 
characters in the file name. Required.

All platforms

Field Description Supported Remote 
Connect:Direct Platforms
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SessionToken Identifies an established session between two 
Connect:Direct nodes. Required. Valid value is 
an XML structure that includes the following 
elements: 
• SessionId
• ProcessNumber
• ProcessName
• SubmitDateTime
• RemoteCDNodeName
• RemoteUserId
• RemotePasswd
• PlexClass
• MaxRestartRetries
• RestartRetryInterval

All platforms

Sysopts Remote system operations to be implemented 
on the remote Connect:Direct node. Optional. 
For example (for copying from Connect:Direct 
Windows only): 
Datatype(text) xlate(yes) 
For more information, see your Connect:Direct 
documentation. 

All platforms
Format of Sysopts varies by 
platform.

Field Description Supported Remote 
Connect:Direct Platforms
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Clustering Considerations

Connect:Direct Server Adapter Configuration
When you configure a Connect:Direct Server adapter in a single node instance of Sterling 
Integrator, the best practice is to use the same name for the Connect:Direct Server adapter Name 
and the Connect:Direct Server Node Name.

When you configure a Connect:Direct Server adapter in a multiple node instance of Sterling 
Integrator, the best practice is to set up one Group Name for the Connect:Direct Server adapters. 
For example, in a two node cluster, the Connect:Direct Server adapter Node Names are NODE1.CD 
and NODE2.CD. Both of these nodes are put in one group called GIS.CD. Provide GIS.CD as the 
Connect:Direct Server Adapter Node Name to your remote Connect:Direct nodes. You will also use 
GIS.CD as the LocalCDNodeName in the CD Server Begin Session Service in your business 
processes.

Note: For additional information about the Connect:Direct Server adapter and multiple node instances of 
Sterling Integrator, refer to the online Sterling Integrator documentation.
Connect:Direct Server Adapter User Guide 131



Appendix C   Clustering Considerations
132 Connect:Direct Server Adapter User Guide



Appendix D

Certificate Wizard

The Certificate Wizard tool is a Web-deployed application that enables you to create the following 
files: 

✦ Certificate Signing Requests (CSRs) - A file is sent by e-mail to a certificate authority to 
request an X.509 certificate.

✦ Key certificates - A combination of an ASCII-encoded certificate and an ASCII-encoded 
PKCS12 encrypted private key (key cert.txt).

✦ Trusted root files - The trusted root file (trusted.txt) contains a list of trusted sources that 
enable the certificate wizard to validate a key certificate and ensure a secure connection. 

Create Directories for Secure+ Option Files
Keeping track of your certificates and CSR files can be challenging. To avoid confusion, create the 
following directory structure on your workstation and store your Connect:Direct for Windows 
Secure+ Option files there:

1. Create a directory on your C: drive and name it MyCDWinSecurePlusFiles.
2. Create the following subdirectories to describe the type of certificate or file that is stored in it 

as described below: 

Subdirectory Description

Certificate Wizard Store your Certificate Wizard download file, CertWizard.V1300.Windows.zip, 
in this directory. 

Private Key Store your private key in this directory. You will create this key when you 
generate your certificate signing request. 

CSR Store your certificate signing request in this directory 

CA Certificate Store your signed CA certificate in this directory. Your CA sends this 
certificate to you after they receive and process your certificate signing 
request. 
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Create the following directory structure on your workstation and store your Connect:Direct Server 
adapter Secure+ Option files there:

1. Create a directory on your C: drive and name it MyCDSASecurePlusFiles.
2. Create the following subdirectories to describe the type of certificate or file that is stored in it 

as described below: 

Download and Install Sterling Certificate Wizard
You can use the same Sterling Certificate Wizard for Connect:Direct and Sterling Integrator, so you 
only need to install it once.

If you have already installed the Sterling Certificate Wizard, go to Generate Certificate Signing 
Request (CSR) on page 136.

Key Certificate Store your key certificate file in this directory. You generate this file in the 
Sterling Certificate Wizard on the Generate Key Certificate tab. 

CA Root Certificate Store your CA root certificate in this directory. This is the root certificate from 
your CA. 

CDSA Root Certificate Store the Connect:Direct Server adapter CA root certificate in this directory. 
This is the root certificate from the Connect:Direct Server adapter CA. 

Subdirectory Description

Private Key Store your private key in this directory. You create this key when you 
generate your certificate signing request. 

CSR Store your certificate signing request in this directory 

CA Certificate Store your signed CA certificate in this directory. Your CA sends this 
certificate to you after they receive and process your certificate signing 
request. 

Key Certificate Store your key certificate file in this directory. You generate this file in the 
Sterling Certificate Wizard on the Generate Key Certificate tab. 

CA Root Certificate Store your CA root certificate in this directory. This is the root certificate from 
your CA. 

CDWin Root Certificate Store the Connect:Direct for Windows CA root certificate in this directory. 
This is the root certificate from the Connect:Direct for Windows CA. 

Subdirectory Description
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Download Sterling Certificate Wizard
Use the following procedure to download the Sterling Certificate Wizard:

1. Log on to your Sterling Customer Center Web site.
2. Click Support on Demand, then Go in the Support on Demand box.
3. From the Support on Demand Product Support menu on the left navigation bar, click Sterling 

> Product Updates & Downloads > Sterling Certificate Wizard. 
4. Download the CertWizard.V1300.Windows.zip file into the 

\MyCDServerSecurePlusFiles\Certificate Wizard directory by clicking the View/Download 
link for Sterling Certificate Wizard 1.3.00 Maintenance for Windows. 

Extract Installation Files
To extract the files, double-click the CertWizard.V1300.Windows.zip file. 

The following files are extracted: 

Install Sterling Certificate Wizard
To install the Sterling Certificate Wizard:

1. Click Start and then click Run.
2. Click Browse.
3. Navigate to the directory that contains the CertWizard.V1300.Win.exe file.
4. Double-click CertWizard.V1300.Win.exe. The program returns to the Run dialog box.
5. Click OK. The installation setup begins.
6. At the Introduction screen, click Next.
7. In the License Agreement dialog box, read the license agreement, click I accept the terms of 

the License Agreement, and click Next.
8. Click Next to continue the installation.
9. Review the installation information and click Install to begin the installation.
10. After copying the files into the program folder, the installation program displays the Install 

Complete dialog box. Click Done to complete the installation. 

File Description

CertWizard.V1300.Win.exe Installation file for Windows system 

readme.txt Contains third-party copyright information 
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Generate Certificate Signing Request (CSR)
You must create a CSR for both your Connect:Direct for Windows system and your Sterling 
Integrator Connect:Direct Server adapter.

Use the following procedure to generate CSRs using the Sterling Certificate Wizard: 

1. Press Start > Programs > Sterling Certificate Wizard V1.3.00 > Sterling Certificate Wizard to 
start the Sterling Certificate Wizard.

2. On the Certificate Wizard Welcome page, click the Generate CSR tab.
3. Type your Connect:Direct node name in the Common Name box.

Common Name is the only required entry on this page.
4. In the Country box, select your country.

If the country you want is not in the list, select Add a New One from the drop-down list and 
type the 2-letter country code in the text box. The country code is not permanently added to the 
list.

5. In the State/Province box, select your country or province.

6. Type your city or locality in the City/Locality box.
7. Type your organization or company name in the Organization/Company Name box.
8. Type up to four organizational units in the Organization Unit(s) box. Press Enter to separate 

each value.
9. Type the email address for the contact at your site in the Email Address box.
10. Click Next.
11. Select 1024 as the length of the private key, from the Private Key Length drop-down list.
12. Type the passphrase to use for encrypting the certificate's private key in the Passphrase box. 

The passphrase should be 6-256 characters.

13. Retype the passphrase in the Confirm Passphrase box for verification.
14. Click Next.
15. In the Cipher drop-down list, select a cipher to encrypt the private key.
16. For the Key File Name, specify C:\My<application>SecurePlusFiles\Private Key\privkey.txt. 

<application> is CDWin for Connect:Direct for Windows or Connect:Direct Server adapter 
for Sterling Integrator.

17. For the CSR File Name, specify C:\My<application>SecurePlusFiles\CSR\csr.txt.

Note: Write down this passphrase. You need this information to use the private key.

Note: The key file is your private key. You need to keep track of its name and location. 
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18. Click Next. A summary screen displays the values you selected for the CSR.
19. Click Next. The CSR is created. 

When you complete this procedure, you will generate two new files: a private key file and a CSR 
file. 

Send the CSR to the Certificate Authority (CA)
You must send CSRs for both your Connect:Direct for Windows system and your Sterling 
Integrator Connect:Direct Server adapter to their respective CAs. You can use the same CA for both 
systems.

Contact your CA to determine a method for sending them your CSR. They will need the following 
information:

✦ Protocol Type: SSL
✦ SSL Certificate Type: not Class 1 or Class 2
✦ Validity period of the certificate
✦ Number of servers requiring a certificate
✦ Technical contact information, including email address and phone number
✦ Server platform: Apache
✦ Organizational information
✦ Billing information
✦ Payment information 
The Certificate Authority performs the following tasks:

1. Verifies your identify—it might require additional information from you for this purpose.
2. Processes the certificate request.
3. Provides you with the following:

A signed CA certificate. Save this file to 
C:\My<application>SecurePlusFiles\CACertificate.

A trusted root certificate. Save this file to C:\My<application>SecurePlusFiles\CA Root 
Certificate.You may need to download this from the CA Web site.

Store the Connect:Direct for Windows root CA file in C:\MyCDSASecurePlusFiles\CDWin Root 
Certificate directory.

Store the Connect:Direct Server adapter root CA file in C:\MyCDWinSecurePlusFiles\CDSA Root 
Certificate directory.

Caution: Never send your private key to your trading partner or anyone else. Keep it secured on your 
Connect:Direct Server in the C:\My<application>SecurePlusFiles\Private Key directory.
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Generate Key Certificate File
You must generate Key Certificate files for both your Connect:Direct for Windows system and your 
Sterling Integrator Connect:Direct Server adapter. You cannot use the same Key Certificate file for 
both systems.

Use the following procedure to create a key certificate file:

1. Click the Generate Key Certificate tab.
2. In the Output Keycert/Keystore Format list box, select Standard.
3. Type C:\My<application>SecurePlusFiles\Private Key\privkey.txt in the Private Key File 

Name box, or click Browse to navigate to the file.
4. Type the passphrase associated with the private key in the Private Key Passphrase field.

You created this passphrase when you generated your CSR in step 12 on page 136.
5. Type the full path, C:\My<application>SecurePlusFiles\CA Certificate, and the CA 

certificate file name in the Certificate File Name field and click Add, or click Browse to 
navigate to the file.

6. Select DES MD5 as the cipher in the Cipher for Encrypting Private Key drop-down list.
7. Select the CA Root must be present check box.
8. Clear the Include CA Root in Keycert check box.
9. Type C:\My<application>SecurePlusFiles\Key Certificate\keycert.txt in the Key Certificate 

File Name box.
10. Click Generate. A message dialog box is displayed when the key certificate file is generated 

successfully.
11. Click OK.
12. Click Exit to close the Sterling Certificate Wizard. 
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Monitoring Business Processes and
Documents

The Sterling Integrator Admin Console enables you to view information about business processes 
that interact with remote Connect:Direct nodes. Correlation records are automatically maintained 
so that you can search for specific information (such as, business process IDs, document IDs, 
workflow IDs, and mailbox IDs). Each business process references a unique business process ID as 
its primary process identifier. 

Tracking and Search Functions
The tracking and search functions available to track Sterling Integrator business processes, 
Connect:Direct processes, and Connect:Direct adapter activity are described in the following table: 

Tracking Option Description

Central Search Use to search for live (active) business process instances that do not appear in the 
Current Processes. Search by Name, Status, or Date. 

Current Processes Lists the status of the ten most recent business process instances.

Current Activities Search for Connect:Direct Server adapter activity by adapter configuration name or 
by when the activity registered within Sterling Integrator. 

Advanced Search

Business 
Processes

Search for active, archived or stored business processes. Search by business 
process instance ID, business process Name, State, or Date. 

Documents Search for active, archived or stored documents handled by a business process. 
Search by Time, Document ID, Sender or Receiver ID, Type, Status or Correlations. 
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When you find the business process you are interested in on any of these Monitor pages, you can 
obtain additional details by selecting the number in the ID column to open the Business Process 
Details page. 

Business Process Detail
The Business Process Detail page is accessed from any page that contains the business process ID. 
This page provides a progress report about a specific business process instance. In addition, you can 
stop or restart the business process from this page. 

Following is a partial list of the information you can obtain from this page: 

✦ The business process definition (the BPML file)
✦ The current state of each step in a business process
✦ The date and time a business process started and ended
✦ The contents of the process data and the primary document at each step of the business process

Current Process Monitor
Selecting Business Processes > Current Processes opens the Monitor page with a list of the 
processes currently running in Sterling Integrator. A Green status indicates no errors or warnings 
occurred during processing. A Red status indicates errors or warnings encountered during 
processing. Use this page to: 

✦ Review detailed processing information by clicking on the ID of the process
✦ View the business process definition by clicking on the Name of the process
✦ View the current state of a business process
✦ View the date and time a business process Started and Ended

Communication 
Sessions

Search for active, archived or stored communication sessions records. These records 
include the associated authentication, authorization, file transfer, or non-file transfer 
records, even if a document is not transferred and no data flow record is created. 
Search by Time, Communication Session ID, Process ID, End Point, Protocol and so 
forth.

Correlation Search for active, archived or stored business processes by name-value pairs. This is 
a key tracking method in interoperability because you can search by values such as 
PNODE, SNODE, Connect:Direct Process Name and so forth.

Tracking Option Description
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Current Activities Monitor
Selecting Business Processes > Current Activities opens the Service Activity search page. The 
Service Activity page enables you to monitor activity of several adapters, including the 
Connect:Direct Server adapter. When you select an adapter to monitor, activity detail occurring on 
the adapter is displayed. 

If the Connect:Direct Server adapter is used by a business process that has stopped running, you can 
use this feature to determine whether the adapter is preventing the business process from running. 

The results of an activities search includes the following information: 

✦ Session identifier
✦ Node name
✦ When the activity started and when it last updated

Correlation Search
Correlation searches are a key to relating a Connect:Direct process with a Sterling Integrator 
business process. Whereas Connect:Direct identifies a process with a Process Number and a 
Process Name, Sterling Integrator identifies its business processes with an Instance ID. The 
Correlation Search enables you to search for Sterling Integrator processes using Connect:Direct 
identifiers.

The Connect:Direct Server adapter and related services automatically write Sterling Integrator 
correlation records to enable searches for business processes and documents containing certain 
correlation identifiers. 

The Correlation Search page enables you to search for business process activity according to six 
Connect:Direct specific name-value pairs, including: 

✦ CD_LocalFileName
✦ CD_RemoteFileName
✦ CD_ProcessName
✦ CD_ProcessNum
✦ CD_PnodeName
✦ CD_SnodeName

Note: Correlations are created to identify related Sterling Integrator and Connect:Direct processes.

Note: Do not perform a correlation search by Process Number only. A Process Number is unique to a 
single Connect:Direct server, therefore you may see the same Process Number used for different 
processes - each associated with a different node.
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Restarting Copy Interruptions

Automatic Retry for Interrupted or Failed Copy Transactions 
The Wait service is used automatically by Sterling Integrator in the event of a failure of the remote 
Connect:Direct node that interrupts a business process, such as one that is performing a 
Connect:Direct copy operation.

A business process suspended by the Wait service needs to be resumed by the scheduled system 
process Schedule_BPExpirator. By default, the BPExpirator is scheduled to run every 15 minutes. 
The BPExpirator schedule can influence checkpoint restart for the adapter. 

If Sterling Integrator stops responding during a copy transaction, and the recovery level is set to 
Auto-Resume, the business process resumes automatically at the next Sterling Integrator start up. 

Checkpoint Restart
The Connect:Direct Server adapter includes parameters to govern checkpoint and restart behavior 
if either Sterling Integrator or the remote node fails. If the remote Connect:Direct server or the 
network fails during a copy operation, the Connect:Direct Server adapter goes into a retry mode 
using the values specified at configuration. The adapter waits for the configured amount of time and 
then resumes the copy. 

Two values impact the amount of time the Connect:Direct Server adapter actually waits to resume 
copy. The first value is the Interval between Retry attempts (minutes) as specified in the 
Connect:Direct Server adapter configuration. The second value is the frequency defined by the 
scheduled system process Schedule_BPExpirator. The larger value governs the checkpoint restart. 

For example, if the Interval between Retry attempts is set to 10 minutes, and the 
Schedule_BPExpirator is scheduled to run every 15 minutes, the retry occurs at the next scheduled 
15 minute interval. Set Schedule_BPExpirator to a much lower number, such as one minute, to 
achieve the fastest restart. 
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Checkpoint restart is supported for both inbound and outbound file transfers in the following 
scenarios:

✦ PNODE Push
✦ PNODE Pull
✦ SNODE Receive
✦ SNODE Send
Checkpoint restart is only supported for documents stored in the file system or mailbox based 
documents.

Checkpoint restart can be enabled whether or not Secure+, compression, or any other 
communications session factor is enabled or disabled.

Restrictions
Checkpoint restart is not available in the following scenarios:

✦ Source or destination files are stored in a database
✦ Source or destination files are stored in the encrypted file system

Purging Checkpoint Data
Sterling Integrator stores checkpoint information for 30 days, after which it is automatically purged. 
If your database is corrupted, you must purge this checkpoint information by performing a cold 
restart. 

To purge checkpoint data: 

1. From the Business Processes menu, search for the adapter configuration.
2. Edit the configuration to set Server Start Option to Cold.
3. Save the changes and click Finish.
4. The Sterling Integrator adapter restarts. The checkpoint data is purged during startup.
5. Edit the configuration again to set Server Start Option to Warm to continue using Checkpoint 

Restart without a loss of information between multiple sessions.
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Troubleshooting

Sterling Integrator and Connect:Direct are designed to work together, in a seamless and tightly 
integrated environment. However, as is the case with any application, occasions may occur when 
you need to troubleshoot certain components or functions. 

This section provides general troubleshooting guidelines when configuring and using Sterling 
Integrator with Connect:Direct. 

To troubleshoot general Connect:Direct functions, see the Connect:Direct documentation set for 
general troubleshooting information and instructions.

You may need to work with your Trading Partners or system administrators to troubleshoot the 
systems you are communicating with.

Verifying Connectivity
To verify connectivity between Connect:Direct and Sterling Integrator: 

1. Check configurations on Connect:Direct and Sterling Integrator for compliance. In particular, 
look at the network maps on both systems. 

2. Verify that the Connect:Direct nodes in question are active when a begin session is invoked.
3. Verify that perimeter services client connects to perimeter services server. If the client cannot 

connect, it causes the perimeter services-enabled Connect:Direct Server adapter to fail. 
Perimeter servers do not automatically reboot after a failure. 
To determine the status of the perimeter services client in Sterling Integrator: 
a. From the Sterling Integrator Operations menu, select Troubleshooter. 
b. Look for the Perimeter Servers area. It is usually at the bottom of the Troubleshooting 

page. This shows the state of the perimeter server clients which are defined in Sterling 
Integrator and whether they are on.
Disconnected is displayed if no perimeter server is installed. 
Connect:Direct Server Adapter User Guide 145



Appendix G   Troubleshooting
Exchanging Process IDs
If either Connect:Direct or Sterling Integrator cannot exchange process identifiers, the process 
correlation in the various monitor user interfaces does not work for the particular instance of a 
process. When this occurs, correct the identifiers and restart the process. 

Business Process Permissions
If you receive permissions-related error messages, make sure that adequate permissions have been 
assigned. 

When a external request is received by Sterling Integrator to execute a business process, the 
user/proxy user must have business process permissions for the specific business process that is to 
be executed. That is, the business process itself must have permissions enabled when it is created. 
In addition, the Sterling user account must have: 

✦ General business process execution permission. This is acquired by assigning the Business 
Processes group to the user account.

✦ Permission for the specific business process to be executed.
The business process will display in the drop down with the mailboxes in the user account 
configuration windows.

Using the Graphical Process Modeler
The following restrictions apply to using the Graphical Process Modeler: 

✦ Do not attempt simultaneous COPY operations for the same node.
✦ Issue a Close Session for each open session when session is finished.

Logging Files
More information, including audit messages and error messages, can be found in Sterling Integrator 
log files. Log files are available through the Operations > System > Logs menu. 

The cdinterop.log files record details for all adapter activity and business processes that involve the 
Connect:Direct Server and Requester adapters and the related Connect:Direct services. 

A new cdintop.log is created each time the Sterling Integrator server is stopped. If it is not stopped 
during a given day, the log grows with each Connect:Direct transaction.
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By default, the cdinterop.log file captures audit level messages, even when logging is not enabled. 
When the log is enabled, all transactions are recorded, including: 

✦ Error messages
✦ Adapter startup and shutdown
✦ Adapter changes
✦ Security checks

Customizing the Connect:Direct Server Adapter Log Settings
You can enhance the logging for the Connect:Direct Server adapter using property files to reduce 
the footprint of the log files and processing overhead.

The log.properties file describes sets of properties required to define a logger used to log 
information to a file, including the cdintop.log. This log.properties file should not be edited. If you 
need to override log.properties settings for the cdintop.log, use the customer_overrides.properties 
file.

The customer_overrides.properties file is used to override property settings in other property files. 
Unlike the other property files and their associated .properties.in files, the 
customer_overrides.properties file is not changed during installation of Application upgrades or 
patches. To prevent having your customized settings overwritten, you should use the customer 
override property file whenever possible rather than editing the Application property files or .in 
files.

The customer_overrides.properties file is not part of the initial Application installation and must be 
created. It must be named customer_overrides.properties.

To override log.properties file settings for the cdintop.log:

1. In the install_dir/properties directory, locate (or create, if necessary) the 
customer_overrides.properties file.

2. Open the customer_overrides.properties file in a text editor.
3. Add the cdintop.log properties that you want to override to the log.properties file, using the 

following format:
logService.PROPERTY_NAME=PROPERTY_VALUE
logService—Name used to reference the log.properties file.
PROPERTY_NAME—Name of the property as used in the log.properties file.
PROPERTY_VALUE—The value you want to assign to the property.

Caution: Overriding the log.properties settings for the cdintop.log can have a dramatic impact on 
performance and log volume
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For example, assume that you want to change the maximum number of cdintop.log files to 5. 
To do so, override the cdinteroplogger.maxnumlogs property value in the log.properties file by 
adding the following line to the customer_overrides.properties file:
logService.cdinteroplogger.maxnumlogs=5

4. Save and close the customer_overrides.properties file.
5. Stop and restart Application to use the new values.
6. Test your changes to ensure that the overrides give the desired results. If you have problems, 

contact Sterling Commerce Customer Support for assistance.

Configuration Settings
The following table describes properties used to configure the customer_overrides.properties file 
for the CDInterop logger:

Property Description

logService.cdinteroplogger.logfilename Specific name of the log file.
Example: ApplicationinstallDir/logs/cdinterop.log

logService.cdinteroplogger.rotatelogs Flag indicating whether to rotate the log after it has reached its 
maximum size.
Example: true

logService.cdinteroplogger.maxlogsize Maximum size of logs of this type.
Example: 100000

logService.cdinteroplogger.maxnumlogs Maximum number of logs of this type.
Example: 10

logService.cdinteroplogger.loglevel A level value of the logger.
Valid entries:
✦ NONE—Log nothing.
✦ CRITICAL—Log critical errors only.
✦ ERROR—Log errors only.
✦ WARN—Log errors and warnings.
✦ INFO—Log INFO and more severe.
✦ TIMING—Log errors, warnings, timing messages.

logService.cdinteroplogger.displayname Display name for the logger.
Example: Log.CDInterop

logService.cdinteroplogger.showsource Flag indicating whether to show the java class that originated 
an error message.
Note: This can have a dramatic impact on performance and 

log volume, so it should only be used to diagnose 
problems.

Example: false
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Turning on Logging
Turning on Logging
If the error is not in the existing logs, turn on the Sterling Integrator cdinterop.log to capture activity 
of the Connect:Direct Server adapter and the services:

1. Browse to Operation > System > Logs.
2. Scroll to the Environment section of the page.
3. Click the edit icon to the left of Connect:Direct Server and Requester Adapter and Services. 
4. In the Environment window, select On next to Logging Level and click Save.
5. Attempt to recreate the problem.
6. View the cdinterop log for more informative entries.
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Appendix H

Use Secure Point of Entry

Secure Point of Entry (SPOE) is a security mechanism for maintaining the privacy of sensitive user 
account information. Privacy is maintained by associating a pseudo-account with an authentic one. 
Remote Connect:Direct trading partners establish sessions using pseudo-accounts rather than 
authentic ones. In this way, sensitive user account information remains private. The 
cdinterop-spoe-policy.properties file describes settings for configuring the Secure Point-of-Entry 
(SPOE) for use with the Connect:Direct Server adapter for inbound requests from remote 
Connect:Direct PNODEs. 

Sterling Integrator also supports Connect:Direct User Proxies as a PNODE whereby the business 
process can designate a RemoteUserId and not provide a RemotePassword. 

Use the following procedure to configure SPOE with the Connect:Direct Server adapter:

1. Enable SPOE Authentication from Remote Connect:Direct PNODEs on page 151
2. Map Connect:Direct User IDs to Sterling Integrator User Accounts on page 152

Enable SPOE Authentication from Remote Connect:Direct 
PNODEs 

SPOE policy may be modified while Sterling Integrator is running. Changes take effect a few 
seconds following the change committal step. To enable SPOE authentication:

1. Make a copy of the SPOE Policy property file:

2. Use a text editor to make the desired changes to the cdinterop-spoe-policy.properties.copy file:

Uncomment the spoe.policy=yes property.

$ cd <install_dir>/properties 
$ cp cdinterop-spoe-policy.properties cdinterop-spoe-policy.properties.copy

$ vi cdinterop-spoe-policy.properties.copy 
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3. Modify other settings in the cdinterop-spoe-policy.properties.copy file necessary for your 
situation. 
See the Sterling Integrator online documentation for more information about the 
cdinterop-spoe-policy.properties file.

4. Save the file.
5. Commit the changes:

Map Connect:Direct User IDs to Sterling Integrator User 
Accounts

After you enable SPOE authentication for the Connect:Direct Server adapter, configure the 
cdinterop-spoe-auth.properties file to map external Connect:Direct user IDs to Sterling Integrator 
user accounts.

Configuration Settings 
The following table describes properties used to configure the cdinterop-spoe-auth.properties file 
in Sterling Integrator:

Each entry associates a SPOE username and remote Connect:Direct node name with a Sterling 
Integrator user account. Each entry in the file consists of a single line of the form: 

$ cd <install_dir>/properties 
$ cp cdinterop-spoe-policy.properties.copy cdinterop-spoe-policy.properties

Syntax Description

spoe-user-id Specifies a unique remote user identifier. The remote user may be specified by an 
asterisk (*) to enable this definition to match any user. 
Note: The asterisk does not perform similar to a wildcard character or regular 

expression operator. It is a special keyword having the meaning "any user." 

nodename Specifies the name of the remote Connect:Direct PNODE node. The node name may 
be specified by an asterisk (*) to enable this definition to match any node. 
Note: The asterisk does not perform similar to a wildcard character or regular 

expression operator. It is a special keyword having the meaning "any 
node." 

gis-user-id Specifies an existing Sterling Integrator user account. 

spoe-user-id@nodename=gis-user-id
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Map Connect:Direct User IDs to Sterling Integrator User Accounts
The @ joins the user identifier with the node name to form the SPOE remote user identifier. No 
space is permitted either before or after it. The = associates the SPOE remote user identifier with 
the Sterling Integrator user account. No space is permitted either before or after it. 

Examples
A remote user id 'user1' is mapped to the gis 'user2' account: 

Any remote id from the cd.chicago node is mapped to the gis account 'chicago': 

The remote id 'anonymous' from the *any* node is mapped to the Sterling Integrator 'anonymous' 
account: 

Any remote id from the *any* node is mapped to the Sterling Integrator 'guest' account: 

Add, Modify, or Delete SPOE User Accounts 
SPOE user accounts may be added, modified, or deleted while Sterling Integrator is running. 
Changes take effect a few seconds following the change committal step. 

To change the cdinterop-spoe-auth.properties file: 

1. Make a copy of the cdinterop-spoe-auth.properties file:

2. Use a text editor to make the desired changes to the cdinterop-spoe-auth.copy file:

3. Save the file.
4. Commit the changes:

user1@cd.logistics=user2 

*@cd.chicago=chicago

anonymous@*=anonymous

*@*=guest 

$ cd <install_dir>/properties 
$ cp cdinterop-spoe-auth.properties cdinterop-spoe-auth.properties.copy

$ vi cdinterop-spoe-auth.properties.copy

$ cd <install_dir>/properties 
$ cp cdinterop-spoe-auth.properties.copy cdinterop-spoe-auth.properties
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Upload and Download Parameters in User and Proxy 
Repositories 

Upload and download parameters can be used to designate where to store incoming files and 
retrieve outgoing files when sent by or requested by a remote node. These can be configured for 
local user accounts or (if SPOE authentication is implemented) for proxy accounts in the 
cdinterop-user-records.properties and cdinterop-proxy-records.properties files, respectively. 

Upload and Download Parameters for Local Users
The cdinterop-user-records.properties file is a User Record Repository that allows the 
Connect:Direct Server adapter to identify a file and how to handle it based on a limited amount of 
information. This allows the Connect:Direct Server adapter to process files despite restrictions such 
as limited file name length. 

Each entry in the cdinterop-user-records.properties file assigns a Sterling Integrator document path 
prefix to a file based on the Connect:Direct Server adapter that receives the request, and the 
combination of remote Connect:Direct PNODE and user ID where the request originated. A 
document path prefix is then assigned and combined with the target or inbound filename to form a 
fully-qualified path name. 

Precedence rules specify processing order in the case of directory parameter conflicts. 

If no entries are defined in the cdinterop-user-records.properties file, the Connect:Direct attempts 
to store or retrieve the file using the path provided in the message protocol. 

Configuration Settings
The following table describes properties used to configure the cdinterop-user-records.properties file 
in Sterling Integrator:

Property Description

directory.precedence Specifies the processing order in cases where two or more directory parameters 
conflict. Example: 
jsmith/download = /mailbox/inbox 
[cdsa-1]download = /mailbox/downloads 

Valid values: 
user—Choose the definition that supplies the Sterling Integrator user account ID. In 
the example above, the first rule is chosen. Default.
adapter—Choose the definition that supplies the Connect:Direct server adapter 
name. In the example above, the second rule will be chosen.

userid An existing local Sterling Integrator user. If omitted, may be any Sterling Integrator 
user. Optional. 
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Syntax 
The cdinterop-user-records.properties file may be modified while Sterling Integrator is running. 
Changes take effect a few seconds following the change committal step. To add or modify entries 
in this file:

1. Make a copy of the cdinterop-user-records.properties file:

2. Use a text editor to make the desired changes to the cdinterop-user-records.properties.copy 
file:

cdsa-name Name of a Sterling Integrator Connect:Direct Server adapter. Syntax: 
[cdsa-name] 
If omitted, all presently defined CDSAs. Optional. 
Note: If omitted, separate the User ID from the upload/download keyword by a 

slash (/) character. 

parameter-name Specifies either the "download" or "upload" keyword. Keywords are not 
case-sensitive. Required. 

download—Designates that the parameter's value identifies the location where 
the incoming file is to be stored. Default (when no other definitions match the 
session's adapter or user account): 
/businessprocess/PO-Request 

upload - Designates that the parameter's value identifies the location from which 
the outgoing file is to be obtained.

gis-path-prefix Path used to store the incoming document or retrieve the outgoing one. Valid 
values: 

/businessprocess/<bp-name> 

where
<bp-name> is the name of a business process. Required.

/mailbox/<path>

where
<path> specifies a target mailbox accessible from the virtual root of the Sterling 
Integrator account. Optional. If omitted, the virtual root is assumed. 

For examples, see Upload and Download Process Examples on page 159. 

$ cd <install_dir>/properties 
$ cp cdinterop-user-records.properties cdinterop-user-records.properties.copy

$ vi cdinterop-user-records.properties.copy

Property Description
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3. To add or modify entries in this file, use this syntax:

If cdsa-name is not specified, separate the User ID from the upload/download parameter name 
with a slash (/). 

4. Save the file.
5. Commit the changes:

Parameter Examples
✦ /mailbox/receipts as a download parameter value—When a remote node connects to 

Connect:Direct Server adapter CDSA.DALLAS using the Sterling Integration user account 
purchasing, this download parameter value is used to compute the destination directory where 
the transmitted file will be stored:

✦ /mailbox/outbox as an upload parameter value—When a remote node connects to any 
Connect:Direct Server adapter using the Sterling Integrator user account purchasing, this 
parameter value is used to compute the source directory location of the file to be transmitted to 
the remote node:

✦ /businessprocess/DelinquentAccounts as an upload parameter value. When a remote 
node connects to C:D Server adapter CDSA-CHICAGO using any Sterling Integrator user 
account, this parameter value determines which business process to execute to produce the 
document's content to be sent to the remote node:

✦ /businessprocess/PO-Request as the default download parameter value. It is used when 
no other definitions match for the session's adapter or user account: 

Upload and Download Parameters for Proxy Users
The cdinterop-proxy-records.properties file serves as Proxy Record Repository for the 
Connect:Direct Server adapter. If a proxied remote user ID (SPOE account) is enabled in the 
cdinterop-spoe-policy.properties file, an upload/download directory path for that proxied user can 
be configured in cdinterop-proxy-records.properties. 

gis-userid / upload | download = gis-path-prefix 
userid ([cdsa-name] | / ) upload | download = gis-path-prefix

$ cd <install_dir>/properties 
$ cp cdinterop-user-records.properties.copy cdinterop-user-records.properties

purchasing[CDSA.DALLAS]download=/mailbox/receipts

purchasing/upload=/mailbox/outbox

[CDSA-CHICAGO]upload=/businessprocess/DelinquentAccounts

download=/businessprocess/PO-Request
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Configuration Settings
The following table describes properties contained in the cdinterop-proxy-records.properties file in 
Sterling Integrator:

Property Description

external-id An external, remote proxied user ID. It may be specified in any of the following 
ways: 

address-form: proxyid @nodename 

where proxyid and nodename are specified. A match occurs only if the user 
name and node name from the request exactly match proxyid and nodename. 
Example:
john@company/upload=/mailbox/company/john/out

The upload path is prepended to the outbound target filename if 
spoe-policy=yes and the remote userid is "john" and the remote pnode 
name is "company."

domain-form: *@nodename

where only nodename is specified. A match occurs only if the node name from 
the request exactly matches nodename. Example: 
*@company/upload=/mailbox/company/out

The upload path is prepended to the outbound target filename if 
spoe-policy=yes and no rule is found for this remote userid, but one is 
found for the remote pnode name "company."

account-form: userid @*

where only proxyid is specified. A match occurs only if the user name from the 
request exactly matches userid. Example: 
john@*/upload=/mailbox/john/out

The upload path is prepended to the outbound target filename if 
spoe-policy=yes and a rule is found for remote userid "john," but no rule is 
found for the name of the remote pnode.

default-form: *@*

This rule always matches any user name from any node name. Example:
*@*/upload=/mailbox/default/out

parameter-name Specifies either the "download" or "upload" keyword. Keywords are not 
case-sensitive. Required. 

download—Designates that the parameter's value identifies the location where 
the incoming file is to be stored. Default (when no other definitions match the 
session's adapter or user account): 
/businessprocess/PO-Request 

upload—Designates that the parameter's value identifies the location from 
which the outgoing file is to be obtained. 
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Syntax 
The cdinterop-proxy-records.properties file may be modified while Sterling Integrator is running. 
Changes take effect a few seconds following the change committal step. To add or modify entries 
in this file:

1. Make a copy of the cdinterop-proxy-records.properties file:

2. Use a text editor to make the desired changes to the cdinterop-proxy-records.properties.copy 
file:

3. To add or modify entries in this file, use this syntax:

4. Save the file.
5. Commit the changes:

gis-path-prefix Path used to store the incoming document or retrieve the outgoing one. Valid 
values: 

/businessprocess/<bp-name> 

where
<bp-name> is the name of a business process. Required.

/mailbox/<path>

where
<path> specifies a target mailbox accessible from the virtual root of the 
Sterling Integrator account. Optional. If omitted, the virtual root is assumed.

$ cd <install_dir>/properties 
$ cp cdinterop-proxy-records.properties cdinterop-proxy-records.properties.copy

$ vi cdinterop-proxy-records.properties.copy

external-id / upload | download = gis-path-prefix 

$ cd <install_dir>/properties 
$ cp cdinterop-proxy-records.properties.copy cdinterop-proxy-records.properties

Property Description
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Upload and Download Process Examples
The following examples show how the parameters are used in two situations: 

✦ Connect:Direct as PNODE Initiates a Transfer TO Sterling Integrator on page 159
✦ Connect:Direct as PNODE Initiates a Transfer FROM Sterling Integrator on page 160

Connect:Direct as PNODE Initiates a Transfer TO Sterling Integrator
In this example, the PNODE is a Connect:Direct Server named CD.CHICAGO. The SNODE is a 
Sterling Integrator Connect:Direct Server adapter named CDSA.DALLAS.

The Connect:Direct process contains the following:

The cdinterop-user-properties file contains the following entries:

The Connect:Direct Server adapter computes the destination filename by appending the local 
filename po-12558-a202 to the cduser1 [CDSA.DALLAS] download parameter value:
Result: /mailbox/in/po-122558-a202

The Connect:Direct User Authorities for cduser1 contains the following Directory Restrictions:

TOGIS PROCESS
SNODE=CDSA.DALLAS
SNODEID=(cduser1,cduser1)

STEP1 COPY
FROM (

FILE=”payload.txt”
)
TO (

FILE=”po-12558-a202”
DISP=RPL

)
PEND

cduser1 [CDSA.DALLAS] upload=/mailbox/out
cduser1 [CDSA.DALLAS] download=/mailbox/in
admin [CDSA.DALLAS] upload=/mailbox/upload
admin [CDSA.DALLAS] download=/mailbox/download

Directory Restriction

Upload C:\Connect Direct\data\upload

Download C:\Connect Direct\data\download
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Connect:Direct computes the source filename by appending the local filename payload.txt to 
user cduser1’s upload parameter value: 
Result: C:\Connect Direct\data\upload\payload.txt

Connect:Direct as PNODE Initiates a Transfer FROM Sterling Integrator
In this example, the PNODE is a Connect:Direct Server named CD.CHICAGO. The SNODE is a 
Sterling Integrator Connect:Direct Server adapter named CDSA.DALLAS.

The Connect:Direct process contains the following:

The cdinterop-user-properties file contains the following entries:

The Connect:Direct Server adapter computes the source filename by appending the local filename 
po-12558-a202 to the cduser1 [CDSA.DALLAS] upload parameter value:
Result: /mailbox/out/po-122558-a202

The Connect:Direct User Authorities for cduser1 contains the following Directory Restrictions:

Connect:Direct computes the destination filename by appending the local filename payload.txt 
to user cduser1’s download parameter value: 
Result: C:\Connect Direct\data\download\payload.txt

FROM GIS PROCESS
SNODE=CDSA.DALLAS
SNODEID=(cduser1,cduser1)

STEP1 COPY
FROM (

FILE=”po-12558-a202”
SNODE

)
TO (

FILE=”payload.txt”
PNODE
DISP=RPL

)
PEND

cduser1 [CDSA.DALLAS] upload=/mailbox/out
cduser1 [CDSA.DALLAS] download=/mailbox/in
admin [CDSA.DALLAS] upload=/mailbox/upload
admin [CDSA.DALLAS] download=/mailbox/download

Directory Restriction

Upload C:\Connect Direct\data\upload

Download C:\Connect Direct\data\download
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